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PSPB_Training 

Line Item 

Operational Revenue Planning 

1.6 - Review Budget 
Successful completion of this task the tester will be able to review the seeded Revenue for 
Appropriated funds and the Balance in $ available to spend. 

Procedure 
 
 

 
 

Step Action 
1. To begin using the application, we must first Log On. 

 
The user name is not case-sensitive 
 
Enter the desired information into the field. Enter "<User Name:>". 

2. Enter the desired information into the field. Enter "<Password>". 
3. Click the Log On button. 
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Step Action 
4. In order to open up the SOKPLAN application the following steps must be 

completed: 
 
Click the Navigate menu. 

 
5. Click the Applications menu. 

 
6. Click the Planning menu. 

 
7. Click the SOKPLAN menu. 

 
8. Navigate to the lower left corner of the page 

 
Click the Preferences Expand button. 

 
9. Click the User Variable Options tab. 
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Step Action 
10. Edit a Selected Member 

-If you want to edit a selected member you can either enter the member directly in 
the field or click on the member selection icon to the right of the "Selected Member" 
column corresponding to the dimension you want to change 
 

11. If not already selected, the following members need to be selected for the first time: 
Scenario: Budget 
Version: Agency 
Year: FY16 
Request: Current Service Level 

12. If User Variables have been changed click the "Save" button (skip this step if No 
changes have been made) 
 
Click the Save button 

 
 

 
 

Step Action 
13. Navigate to the View Pane on the left side of the page 

 
Click the My Task List Expand button. 

 



 

 Page 4 

Step Action 
14. Navigate to the View Pane 

 
Click the Operational Planning folder 
 
E.g.: 
 
Click the Operational Planning object. 

 
15. Navigate to the Operational Planning Tasks within the content area on the right side 

of the page 
 
Click the Review Budget button. 

 
16. Hide the View Pane (if not already hidden) by clicking the collapse pane arrow 

button on the left 
 
Click the Collapse Pane button. 
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Step Action 
17. Adjust View for Form - (Select summary level values for all page drop downs) 

 
Pages drop downs are : 
Entity : < Select Desired Agency/Division/DeptID> , Program : <Select 
All_Program>, Operating Unit: <Select Agency_OPR_PRODUCT>, CFDA: 
<Select All_CFDA> , Project: <Select All_Projects> 
 
For E.g. Entity: 26500 (Dept of Education), Program: All_Program, Operating 
Unit: 26500_OPR_PRODUCT, CFDA: All_CFDA, Project: All_Projects 
 
Note: Enter "All_" or "All " in the member fields to filter to: All_Program, 
All_Projects, All_CFDA 
 

 

 
 

Step Action 
18. To set form to POV selections click the "Go" button 

 
Click the Go button. 

 
19. Unhide the View Pane by clicking the collapse pane arrow button on the left 

 
Click the Restore Pane button. 
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Step Action 
20. Review the data in the form: 

 
Form Rows are : 
<List of Agency Class Fund categories> 
 
Form Columns are : 
 
FY16, Budget, 4 - Revenue and 5 - Expenditures 
Balance in $ and Balance in % is variance between  account group 4 and 5 
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Step Action 
21. Complete the "Review Budget" Task 

 
Click the Complete option. 

 
22. Click the Next button. 

 
23.  

End of Procedure. 

1.7 - Read Budget Request Instructions 
In this topic you will be able to open up Budget Request Instructions document and read planning 
instructions. 

Procedure 
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Step Action 
1. Review the Budget Request instructions 

 
[Note: Verify that it is the current year's instruction guide] 

2. Use the vertical scroll bar to scroll through the document for review 
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Step Action 

3. Complete the "Read Budget Requests Instructions" Task 
 
Click the Complete option. 

 
4. Click the Next button. 

 
5.  

End of Procedure. 

1.8 - Provide or verify Agency Information 
In this topic you will update Agency information related to Mailing Address, Agency Head, 
Contact Person, Agency Details, Management and Board Members. 

Procedure 
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Step Action 
1. Adjust View for Form  

 
Pages drop downs are : 
Entity : < Select Desired Agency> , Year : <Select FYXX> 
 
For E.g. Entity: 26500 (Dept of Education), Year: FY16  
 
Click the Go button. 

2. To view instructions for this Task, click the Task Instructions tab 
 
Click the Task Instructions tab. 
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Step Action 
3. Review the task instructions: 

 
[Note: Data my already be entered in forms and only require review/updates.] 
 
Provide Data in Forms 
-On "Agency Mailing Address" tab, select values for Agency Status 
(Active/Inactive), Agency Type(Appropriated/Non_app) and Historical Budget Book 
(Yes/No) for including this agency for HBB 
-"Agency Head"  tab and enter required details in cells 
-"Alternate Contact Person"  tab and enter required details in cells 
-"Agency Details"  tab and enter required details in cells. Select value for 
Governing Body (Board, Council etc.) from the drop down 
-"Agency Management"  tab and enter required details in cells 
-"Board or Commission Members"  tab and enter required details in cells 

 

 
 

Step Action 
4. Navigate back to the Task forms 

 
Click the Task - 3. Provide or verify Agency Information-LineItem_01_Agency 
Information tab. 

 



 

 Page 12 

 
 

Step Action 
5. Review/Update data in form.  Proceed to next form when finished. 

 
Click the Agency Head tab. 

 
6. Review/Update data in form.  Proceed to next form when finished. 

 
Click the Alternate Contact Person tab. 

 
7. Review/Update data in form.  Proceed to next form when finished. 

 
Click the Agency Details tab. 

 
8. Review/Update data in form.  Proceed to the next form when finished. 

 
Click the Agency Management tab. 

 
9. Review/Update data in form.  Proceed to next form when finished. 

 
Click the Board or Commission Members tab. 
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Step Action 
10. Enter a new board member by navigating to blank row and entering data for all the 

fields in that row 
 
[Note: You can either click tab to navigate to the next field or click a specific cell] 
 
 
Enter the desired information into the Row 9.. Column Member Name and Title 
field. Enter "Michael Sam, Member". 

11. Enter the desired information into the Row 9.. Column Member Appointing 
Authority field. Enter "Governor with State Senate Confirmation". 

12. Enter the desired information into the Row 9.. Column Member Expiration Date 
field. Enter "2/15/2019". 

13. Enter the desired information into the Row 9.. Column Member Address Line 1 
field. Enter "P.O. Box 223". 

14. Enter the desired information into the Row 9.. Column Member Address City 
field. Enter "Oklahoma City". 

 

 
 

Step Action 
15. Use the horizontal scroll bar to view the whole form 
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Step Action 
16. Enter the desired information into the Row 9.. Column Member Address State 

field. Enter "OK". 
17. Enter the desired information into the Row 9.. Column Member Address Zip 

Code field. Enter "73134.000000". 
18. Enter the desired information into the Row 9.. Column Member Work Phone 

field. Enter "405-222-2323". 
19. Enter the desired information into the Row 9.. Column Member Email field. Enter 

"addyforMSam". 
20. Save the newly added board member information. 

 
Click the Save button. 

 
21. A message displays reading "The data has been saved." 

 
Click the OK button. 

 
22. Complete the "Provide or verify Agency Information" Task 

 
Click the Complete option. 

 
23. Click the Next button. 
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Step Action 
24.  

End of Procedure. 

1.9 - Provide Agency Program Summary 
In this topic you will update Agency Program details for multiple programs. 

Procedure 
 
 

 
 

Step Action 
1. This Task contains subtasks which must be completed individually 

 
Navigate to the View Pane on the left side of the page 
 
Click the Provide Agency Program information Expand button. 

 
2. Click the Provide Agency Program Summary object. 
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Step Action 
3. Adjust View for Form  

 
Pages drop downs are : 
Entity : < Select Desired DeptID>  
 
For E.g. Entity: 26500_0100001  
 
[Note:  This form will be populated for each of your agency’s programs/divisions.  
Enter only one program here.] 
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Step Action 
4. Click the Go button. 
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Step Action 
5. Provide Data in Form 

-Review the questions in the "Input Required" form 
 
[NOTE:  By placing the mouse over the edge of the column header, as in Excel, you 
can drag the column width narrower and wider, in order to see the entire 
questions.] 

6. Provide Data in Form 
-Enter the answers in all the fields in the "Response" form referencing the "Input 
Required" form for the questions  
 
-Click in each cell to enter question 
 

 

 
 

Step Action 
7. Enter the desired information into the Row P1.. Column Response: field. Enter 

"None". 
8. Enter the desired information into the Row P2.. Column Response: field. Enter 

"Provide a valid purpose for the Program". 
9. Enter the desired information into the Row P3.. Column Response: field. Enter 

"Provide direct benefits of this Program". 
10. Enter the desired information into the Row P4.. Column Response: field. Enter 

"Provide benefits to other agencies". 
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Step Action 
11. Enter the desired information into the Row P5.. Column Response: field. Enter 

"None". 
12. Enter the desired information into the Row P9.. Column Response: field. Enter 

"Describe how the clients are served". 
13. Enter the desired information into the Row P10.. Column Response: field. Enter 

"Discuss any consequences". 
14. Enter the desired information into the Row P11.. Column Response: field. Enter 

"None". 
15. Enter the desired information into the Row P12.. Column Response: field. Enter 

"None". 
 

 
 

Step Action 
16. Click the Save button. 
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Step Action 
17. A message appears reading "The data has been saved." 

 
Point to the OK button. 

18. Complete the "Provide Agency Program Summary" Task 
 
Click the Complete option. 

19. Click the Next button. 

 
20.  

End of Procedure. 

1.10 - Define Agency Program Performance 
In this topic you will update Agency Program Goals and Program evaluation. 
 

Procedure 
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Step Action 
1. Adjust View for Form  

 
Pages drop downs are : 
Entity : < Select Desired DeptID>  
 
For E.g. Entity: 26500_0100001  
 
Click the Go button. 

 
2. Enter the desired information into the Row Goal#1. Column FY16 Summary of 

long-term goals and measures: * field. Enter "To develop effective and 
successful planning". 

3. Click the File menu. 
 

4. Click the Save menu. 

 
5. A message displays reading "The data has been saved." 

 
Click the OK button. 

 
6. Click the Agency Program Goal KPMs tab. 
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Step Action 
7. Enter the desired information into the Row Goal#1. Column FY16 Budget Short 

Description field. Enter "Improve Planning". 
8. Enter the desired information into the Row G1-KPM1. Column FY16 Budget 

Short Description field. Enter "Project Management Skill Development". 
9. Enter the desired information into the Row G1-KPM1. Column FY16 Budget 

Long Description field. Enter "This is measured in how many PM courses are 
utilized by State employees". 

10. Enter the desired information into the Row G1-KPM1. Column FY16 Budget 
Measure Values field. Enter "8424". 

11. Enter the desired information into the Row G1-KPM1. Column FY17 Budget 
Measure Values field. Enter "8424". 

12. Enter the desired information into the Row G1-KPM1. Column FY18 Budget 
Measure Values field. Enter "8425". 

13. Enter the desired information into the Row G1-KPM1. Column FY19 Budget 
Measure Values field. Enter "8425". 

 

 
 

Step Action 
14. Use the horizontal scroll bar to scroll to the right to view the whole form 
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Step Action 
15. Enter the desired information into the Row G1-KPM1. Column FY16 Budget 

Measure Values Comments field. Enter "Number of trips". 
16. Click the File menu. 

 
17. Click the Save menu. 

 
18. A message displays reading "The data has been saved." 

 
Click the OK button. 

 
19. Click the Agency Program evaluation tab. 

 
20. Navigate to the question beginning with "Does this program..." 

 
Click the 1st Row SmartList dropdown button to activate the menu. 

 
21. Click the Yes list item. 

 
22. Navigate to the question beginning with "Are the users..." 

 
Click the 2nd Row SmartList dropdown button to activate the menu. 
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Step Action 
23. Click the Yes list item. 

 
24. Navigate to the question beginning with "Does the state..." 

 
Click the 3rd Row SmartList dropdown button to activate the menu. 

 
25. Click the No list item. 

 
26. Navigate to the question beginning with "If yes, do individual..." 

 
Click the 4th Row SmartList dropdown button to activate the menu. 

 
27. Click the No list item. 

 
28. Navigate to the question beginning with "Is the service..." 

 
Click the 5th Row SmartList dropdown button to activate the menu. 

 
29. Click the Yes list item. 

 
30. Navigate to the question beginning with "Do other states..." 

 
Click the 6th Row SmartList dropdown button to activate the menu. 

 
31. Click the Yes list item. 

 
32. Enter the desired information into the 7th Row If yes, please summarize their 

experience with the charges. Column FY16 Budget field. Enter "None". 
33. Navigate to the question beginning with "Are there any related..." 

 
Click the 8th Row SmartList dropdown button to activate the menu. 

 
34. Click the No list item. 

 
35. Enter the desired information into the 9th Row If any exist, summarize service 

and related benefits to users and public. Column FY16 Budget field. Enter 
"None". 

36. Enter the desired information into the 10th Row Discussion of user fees *. Column 
FY16 Budget field. Enter "Details provided". 

37. Click the File menu. 
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Step Action 
38. Click the Save menu. 

 
39. A message displays reading "The data has been saved." 

 
Click the OK button. 

 
40. Complete the "Define Agency Program Performance 

Click the Complete option. 
 

41. Click the Next button. 
 

42.  
End of Procedure. 

1.11 - Identify Anticipated Fee Based Revenue 
In this topic you will add New Agency fees, update Fees Schedule and thereby plan Fee-based 
revenues for the current year. 

Procedure 
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Step Action 
1. This Task contains subtasks which must be completed individually 

 
Navigate to the View Pane on the left side of the page 
 
Click the Plan Agency Revenue Expand button. 

 
2. Click the Identify anticipated Fee based revenues object. 

 
3. If not already hidden, hide the View Pane 

 
Click the Collapse Pane button. 

 
4. Adjust View for Form (Select lowest level values in page drop downs) 

 
Pages drop downs are : 
Entity : < Select Desired DeptID> , ClassFund: <Select Desired ClassFund> 
Operating Unit: <Select Desired OU_Product> 
 
For E.g.: 
Entity: 26500_0100001 (Administrative Services), ClassFund: No Class Fund, 
Operating Unit: 26500_NoOPR_NoPRD 
 
Click the Go button. 
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Step Action 

5. Provide Anticipated Fee Based Revenues 
-Expand the Account row by clicking on the "Drill Expand" button on that row 
-Right-click a column header in the "Agency Request" column for the current 
Budget Year 
-Click 'Fees Planning' from the Menu 
 

 
 

 
 

Step Action 
6. E.g.: 

 
Click the 4239 - Education Expand button. 

 
7. Navigate to any of the column headers in the Agency Request column for the current 

budgeting year column (e.g. FY16) 
 
Right-click the Column Header cell. 

 
8. Click the Fees Planning menu. 
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Step Action 
9. Right click any of the row headers  

 
E.g. 
 
Right-click the Row Header object. 

 
10. Click the Add New Agency Fee menu. 

 
11. NOTE:  

-New Fee Name should not have (") or (') characters 
-New Fee Name should not be same as an existing fee name  
 
Enter the desired information into the *Enter Fee Name field. Enter "New 
Education Fee". 

12. Click the Launch button. 

 
13. A message displays reading "LI_Add New Fee was successful." 

 
Click the OK button. 

 
14. Navigate to the first cell in the row and enter data.  To move to the next  column 

click that cell or use the TAB key 
 
Enter the desired information into the Row New Education Fee. Column FY16 
BegBalance Budget Statutory Reference field. Enter "Statutory Reference". 

15. Enter the desired information into the Row New Education Fee. Column FY16 
BegBalance Budget Describe the fee (what is the name of the free; who pays i, 
and so-forth) field. Enter "This is the New Education Fee". 

16. Enter the desired information into the Row New Education Fee. Column FY16 
BegBalance Budget If you are anticipating or requesting any fee increases. * 
field. Enter "No". 

17. Enter the desired information into the Row New Education Fee. Column FY16 
BegBalance Budget Additional Comments: field. Enter "None". 
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Step Action 
18. Use the horizontal scroll bar to view the rest of the form 
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Step Action 
19. Enter the desired information into the Row New Education Fee. Column FY16 

BegBalance Budget Payer field. Enter "State Agency". 
20. Click the Fee Revenue Account SmartList dropdown button to activate the menu. 

 
21. -Select an appropriate GL Revenue account for the Agency Fee 

 
Click the Free Revenue Account SmartList dropdown button to activate the menu. 

 
22. Enter the desired information into the Name field. Enter "423920". 
23. Click in the 423920-IdentificationCardFee field. 

 
24. Click the File menu. 

 
25. Click the Save menu. 

 
26. A message appears reading "The data has been saved.  Rule was run successfully" 

 
Click the OK button. 

 
27. Click the Fee Revenue Details tab. 
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Step Action 
28. Use the horizontal scroll bar to view the rest of the form 
29. -Under current Budget Year, fill up "Rate/Schedule" , "Number Issued", and "Fee 

Revenue" 
-Enter data in the appropriate cells 
 

 
 

 
 

Step Action 
30. Enter the desired information into the Row New Education Fee. Column FY16 

YearTotal Rate/Schedule field. Enter "250". 
31. Enter the desired information into the Row New Education Fee. Column FY16 

YearTotal Number Issued field. Enter "250". 
32. Enter the desired information into the Row New Education Fee. Column FY16 

YearTotal Fee Revenue field. Enter "4000". 
33. Click the File menu. 

 
34. Click the Save menu. 
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Step Action 
35. A message appears reading "The data has been saved.  Rule was run successfully" 

 
Click the OK button. 

 
36. View the Results 

 
Click the Revenue_02a_Licenses, Permits and Fees link. 

 
 

 
 

Step Action 
37. Locate the GL Revenue Account that was selected for the Fee  

 
The data appears in the cell 
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Step Action 
38. Complete the "Identify Anticipated Fee Based Revenue" Task 

 
Click the Complete option. 

 
39. Click the Next button. 

 
40.  

End of Procedure. 

1.12 - Identify other Revenue Streams - Taxes 
In this topic you will enter revenue values for taxes based on multiple revenue accounts. 

Procedure 
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Step Action 
1. Click the Next button. 
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Step Action 
2. Select level of detail to view revenue streams 

 
Verify your POV and change as needed and described below. 
 
Adjust View for Form (Select lowest level values in page drop downs) 
 
Pages drop downs are : 
Entity : < Select Desired DeptID> , ClassFund: <Select Desired ClassFund>, 
Operating Unit: <Select Desired OU_PRD>, Program: <Select Program> 
 
For E.g.: 
 Entity: 26500_0100001 (Administrative Services), ClassFund: 26500_10000, 
Operating Unit: 26500_NoOPR_NoPRD, Program: No_Program 
 

 

 
 

Step Action 
3. Click the Entity dropdown button to activate the menu. 

 
4. Enter the desired information into the Member field. Enter "34500_68". 



 

 Page 36 

Step Action 
5. Click the 7-digit department list item:  

 
E.g.: 
 
Click the 34500_6800001 - Highway list item. 

 
6. Click the ClassFund dropdown button to activate the menu. 

 
7. Click the 7-digit department list item:  

 
E.g.: 
 
Click the 34500_40000 - County Bridge Revolving Fund list item. 

 
 

 
 

Step Action 
8. Verify that Operating Unit is set to <5 digit agency>_No_OPR_NoPRD 

 
E.g.: 34500_NoOPR_NoPRD 
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Step Action 
9. Verify that Program is set to No Program 

 
E.g.: No Program 

 
 

 
 

Step Action 
10. Click the Go button. 

 
11. Provide Taxes Revenue 

-Expand the row by clicking on the "Drill Expand" button on that row and go the 
lowest level of GL Account 
-Enter data in the fields under the "FY16" column 
 
Click the account code of choice. E.g. 4112 - Tobacco Taxes Use the drill button to 
expand to the detail account code level. 
 
Click the 4112 - Tobacco Taxes Expand button. 

 
12. Enter the desired information into the white field for your selected detail account 

code for FY16. Enter a valid value e.g. "2000". 
 
Enter the desired information into the 411201 - Cigarette Tax. FY16/ YearTotal/ 
Budget/ Agency Request field. Enter "2000". 
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Step Action 
13. Enter the desired information into the white field for your selected detail account 

code for FY16. Enter a valid value e.g. "3000". 
 
Enter the desired information into the 411210 - Tobacco Products Tax. FY16 
YearTotal/ Budget/ Agency Request field. Enter "3000". 

14. Enter the desired information into the white field for your selected detail account 
code for FY16. Enter a valid value e.g. "4000". 
Enter the desired information into the 411219 - Tribal Compact InLieu Tax Pmts. 
FY16 /YearTotal/ Budget/ Agency Request field. Enter "4000". 

15. Click the File menu. 
 

16. Click the Save menu. 

 
17. A message dialog box displays: "The data has been saved" 

 
Click the OK button. 

 
18. Complete the "Identify other Revenue Streams - Taxes" Task 

 
Click the Complete option. 

 
19. Click the Next button. 

 
20.  

End of Procedure. 

1.13 - Identify other Revenue Streams - Fines, Forfeits, and Penalties 
In this topic you will enter revenue values for fines, forfeits, and penalties based on multiple 
revenue accounts 

Procedure 
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Step Action 
1. If your POV is not to most detailed terms, please adjust. 

 
The forms retain POV members from previous forms 
 
Adjust View for Form (Select lowest level values in page drop downs) 
 
Pages drop downs are : 
Entity : < Select Desired DeptID> , ClassFund: <Select Desired ClassFund>, 
Operating Unit: <Select Desired OU_PRD>, Program: <Select Program> 
 
For E.g. Entity: 26500_0100001 (Administrative Services), ClassFund: 
26500_10000, Operating Unit: 26500_NoOPR_NoPRD, Program: No_Program 
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Step Action 
2. Click the Go button. 

 
3. Provide Fines, Forfeits, and Penalties Revenue 

-Expand the row by clicking on the "Drill Expand" button on that row and go the 
lowest level of GL Account 
-Enter data in the fields under the "FY16" column 
 
Click the desired account roll-up and expand to detail account code level.  E.g. 4321 
- Crime Victims Compensation Bd Drill Expand button. 
 
Click the 4321 - Crime Victims Compensation Bd Expand button. 

 
4. Enter the desired information into the select detail account Row 

 
Enter the desired information into the Row 432101 - Crime Victim 
Compenstn.Assesmt. Column FY16 YearTotal Budget Agency Request field. 
Enter "2000". 

5. Click the desired account roll-up and expand to detail account code level.  E.g. 4331 
- Other Drill Expand 
 
Click the 4331 - Other Expand button. 
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Step Action 
6. Enter the desired information into the select detail account Row 

 
Enter the desired information into the Row 433102 - Library Fine. Column FY16 
YearTotal Budget Agency Request field. Enter "300". 

7. Enter the desired information into the select detail account Row 
 
Enter the desired information into the Row 433103 - Parking Fine. Column FY16 
YearTotal Budget Agency Request field. Enter "700". 

8. Click the File menu. 
 

9. Click the Save menu. 

 
10. Complete the "Identify other Revenue Streams - Fines, Forfeits, and Penalties" Task 

 
Click the Complete option. 

 
11. Click the Next button. 

 
12.  

End of Procedure. 

1.14 - Identify other Revenue Streams - Income from Money and Property 
In this topic you will enter revenue values for income from money and property based on multiple 
revenue accounts. 

Procedure 
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Step Action 
1. Adjust View for Form (Select lowest level values in page drop downs) 

 
Verify all are at the most detailed level.  If not, please adjust as instructed below. 
 
Pages drop downs are : 
Entity : < Select Desired DeptID> , ClassFund: <Select Desired ClassFund>, 
Operating Unit: <Select Desired OU_PRD>, Program: <Select Program> 
 
For E.g. Entity: 26500_0100001 (Administrative Services), ClassFund: 
26500_10000, Operating Unit: 26500_NoOPR_NoPRD, Program: No_Program 
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Step Action 
2. Change the Class Fund 

 
Click the ClassFund dropdown button to activate the menu. 

 
3. Enter the desired information into the Member field. Enter "34500_". 
4. Click the 5-digit Class Fund: 

 
E.g. 34500_90000 - Employer Benefits & Taxes 
 
Click the 34500_90000 - Employer Benefits & Taxes list item. 

 
5. Click the Go button. 
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Step Action 
6. Provide Income from Money and Property 

-Expand any of the account code rows by clicking on the "Drill Expand" button for 
that row and go the lowest level of GL Account 
-Enter data in the fields under the "FY16" column 
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Step Action 
7. Click the selected account code drill down to expand to the detail account code 

level.  
 
E.g.: 
 
Click the 4411 - Investment Income Drill Expand button. 

 
8. Enter the desired information into the select detail account Row 

 
E.G: 
 
Enter the desired information into the Row 441101 - Interest on Bank Deposits. 
Column FY16 YearTotal Budget Agency Request field. Enter "12000". 

9. Enter the desired information into the select detail account Row 
 
E.G: 
 
Enter the desired information into the Row 441105 - Interest on Investments. 
Column FY16 YearTotal Budget Agency Request field. Enter "70000". 

10. Enter the desired information into the select detail account Row 
 
E.G: 
 
Enter the desired information into the Row 441115 - Income Investmt of 
Endowmnt Fd. Column FY16 YearTotal Budget Agency Request field. Enter 
"2000". 
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Step Action 
11. Click the File menu. 

 
12. Click the Save menu. 

 
13. A message dialog box displays: "The data has been saved" 

 
Click the OK button. 

 
14. Complete the "Identify other Revenue Streams - Income from Money and Property" 

Task 
 
Click the Complete option. 

 
15. Click the Next button. 

 
16.  

End of Procedure. 

1.15 - Identify other Revenue Streams - Higher Education - Student Fees 
In this topic you will enter revenue values for higher education student fees based on multiple 
revenue accounts. 

Procedure 
 
 



 

 Page 47 

 
 

Step Action 
1. Adjust View for Form (Select lowest level values in page drop downs) 

 
Pages drop downs are : 
Entity : < Select Desired DeptID> , ClassFund: <Select Desired ClassFund>, 
Operating Unit: <Select Desired OU_PRD>, Program: <Select Program> 
 
For E.g. Entity: 26500_0100001 (Administrative Services), ClassFund: 
26500_10000, Operating Unit: 26500_NoOPR_NoPRD, Program: No_Program 
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Step Action 
2. Click the Entity dropdown button to activate the menu. 

 
3. Enter the desired information into the Member field. Enter "34500_22". 
4. Click the 7-digit department list item:  

 
E.g.: 
 
Click the 34500_2200001 - Railroads list item. 

 
5. Click the ClassFund dropdown button to activate the menu. 

 
6. Enter the desired information into the Member field. Enter "34500_57600". 
7. Click the desired five-digit class fund:  

 
E.g.:  
 
Click the 34500_57600 - Special Cash Fund list item. 

 
8. Click the Go button. 
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Step Action 
9. Provide Higher Education - Student Fees 

-Expand the row by clicking on the "Drill Expand" button on that row and go the 
lowest level of GL Account 
-Enter data in the fields under the "FY16" column 
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Step Action 
10. Click the selected account code drill down to expand to the detail account code 

level. E.g. 4411 - Investment Income Drill Expand button. 
 
Click the 4611 - Tuition & Instruction Fees Drill Expand button. 

 
11. Enter the desired information into the select detail account Row 

 
E.G: 
 
Enter the desired information into the Row 461101 - General Enrollment Fee. 
Column FY16 YearTotal Budget Agency Request field. Enter "2000". 

12. Enter the desired information into the select detail account Row 
 
E.G: 
 
Enter the desired information into the Row 461105 - Non-Resident Tuition Fee. 
Column FY16 YearTotal Budget Agency Request field. Enter "2000". 

13. Enter the desired information into the select detail account Row 
 
E.G: 
 
Enter the desired information into the Row 461112 - Correspondence Study Fee. 
Column FY16 YearTotal Budget Agency Request field. Enter "1000". 

14. Click the File menu. 
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Step Action 
15. Click the Save menu. 

 
16. A message dialog box displays: "The data has been saved" 

 
Click the OK button. 

 
17. Complete the "Higher Education - Student Fees" Task 

 
Click the Complete option. 

 
18. Click the Next button. 

 
19.  

End of Procedure. 

1.16 - Identify other Revenue Streams - Sales and Services 
In this topic you will enter revenue values for other revenue streams based on multiple revenue 
accounts. 

Procedure 
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Step Action 
1. If not already done: Adjust View for Form (Select lowest level values in page drop 

downs) 
 
Pages drop downs are : 
Entity : < Select Desired DeptID> , ClassFund: <Select Desired ClassFund>, 
Operating Unit: <Select Desired OU_PRD>, Program: <Select Program> 
 
For E.g. Entity: 26500_0100001 (Administrative Services), ClassFund: 
26500_10000, Operating Unit: 26500_NoOPR_NoPRD, Program: No_Program 
 

 

 
 

Step Action 
2. Click the ClassFund dropdown button to activate the menu. 

 
3. Enter the desired information into the Member field. Enter "34500_". 
4. Click the detail class fund list item: e.g. 34500_22500 - Public Transit Revolving 

Fund 
 
Click the 34500_22500 - Public Transit Revolving Fund list item. 

 
5. Click the Go button. 
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Step Action 
6. Provide Sales and Services details 

-Expand the row by clicking on the "Drill Expand" button on that row and go the 
lowest level of GL Account 
-Enter data in the fields under the "FY16" column 
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Step Action 
7. Click the selected account code drill down to expand to the detail account code 

level. E.g. 4711 - Agricultural Drill Expand Expand button. 
 
Click the 4711 - Agricultural Drill Expand button. 

 
8. Enter the desired information into the select detail account Row 

 
E.G: 
 
Enter the desired information into the Row 471111 - Extension Division Income. 
Column FY16 YearTotal Budget Agency Request field. Enter "1000". 

9. Enter the desired information into the select detail account Row 
 
E.G: 
 
Enter the desired information into the Row 471122 - Farm Products General. 
Column FY16 YearTotal Budget Agency Request field. Enter "5000". 

10. Enter the desired information into the select detail account Row 
 
E.G: 
 
Enter the desired information into the Row 471124 - Farm Products Dairy. 
Column FY16 YearTotal Budget Agency Request field. Enter "1000". 
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Step Action 
11. Click the selected account code drill down to expand to the detail account code 

level. E.g. 4761 - Rents Drill Expand 
 
Click the 4761 - Rent Expand button. 

 
12. Enter the desired information into the Row 476137 - Housing Other. Column 

FY16 YearTotal Budget Agency Request field. Enter "10000". 
13. Click the File menu. 

 
14. Click the Save menu. 

 
15. A message box displays reading the data has been saved 

 
Click the OK button. 

 
16. Complete the "Sales and Services" Task 

 
Click the Complete option. 

 
17. Click the Next button. 

 
18.  

End of Procedure. 

1.17 - Identify other Revenue Streams - Non Revenue Receipts 
In this topic you will enter revenue values for non-revenue receipts based on multiple revenue 
accounts. 

Procedure 
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Step Action 
1. Adjust View for Form (Select lowest level values in page drop downs) 

 
Pages drop downs are : 
Entity : < Select Desired DeptID> , ClassFund: <Select Desired ClassFund>, 
Operating Unit: <Select Desired OU_PRD>, Program: <Select Program> 
 
For E.g. Entity: 26500_0100001 (Administrative Services), ClassFund: 
26500_10000, Operating Unit: 26500_NoOPR_NoPRD, Program: No_Program 
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Step Action 
2. Click the Entity dropdown button to activate the menu. 

 
3. Click the desired 7-digit department list item:  

 
e.g.: 
 
Click the 34500_2300001 - Waterways list item. 

 
4. Click the ClassFund dropdown button to activate the menu. 

 
5. Click the desired class fund list item:  

 
E.g.: 
 
Click the 34500_29000 - State Transportation Fund list item. 

 
6. Click the Go button. 
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Step Action 
7. Provide Non Revenue Receipts details 

-Expand the row by clicking on the "Drill Expand" button on that row and go the 
lowest level of GL Account 
-Enter data in the fields under the "FY16" column 
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Step Action 
8. Click the selected account code drill down to expand to the detail account code 

level. E.g. 4811 - Contribs, Judgements&Forefeits Drill Expand 
 
Click the 4811 - Contribs, Judgements&Forefeits Drill Expand button. 

 
9. Enter the desired information into the select detail account Row 

 
E.G: 
 
Enter the desired information into the Row 481116 - Contributions - Other. 
Column FY16 YearTotal Budget Agency Request field. Enter "7000". 

10. Click the File menu. 
 

11. Click the Save menu. 

 
12. A message displays reading the data has been saved 

 
Click the OK button. 

 
13. Complete the "Non Revenue Receipts" Task 

 
Click the Complete option. 
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Step Action 
14. Click the Next button. 

 
15.  

End of Procedure. 

1.18 - Identify other Revenue Streams - Other Revenue Transactions 
In this topic you will enter revenue values for other revenue transactions based on multiple 
revenue accounts. 

Procedure 
 
 

 
 

Step Action 
1. Adjust View for Form (Select lowest level values in page drop downs) 

 
Pages drop downs are : 
Entity : < Select Desired DeptID> , ClassFund: <Select Desired ClassFund>, 
Operating Unit: <Select Desired OU_PRD>, Program: <Select Program> 
 
For E.g. Entity: 26500_0100001 (Administrative Services), ClassFund: 
26500_10000, Operating Unit: 26500_NoOPR_NoPRD, Program: No_Program 
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Step Action 
2. Click the ClassFund dropdown button to activate the menu. 

 
3. Enter the desired information into the Member field. Enter "34500_5". 
4. Click the desired class fund list item: 

 
E.G.: 
 
Click the 34500_57600 - Special Cash Fund list item. 

 
5. Click the Go button. 
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Step Action 
6. Provide Other Revenue Transactions details 

-Expand the row by clicking on the "Drill Expand" button on that row and go the 
lowest level of GL Account 
-Enter data in the fields under the "FY16" column 
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Step Action 
7. Click the selected account code drill down to expand to the detail account code 

level. E.g. 4761 - Rents Drill Expand 
 
Click the 4997 - PY Exp in Current FY Drill Expand button. 

 
8. Enter the desired information into the select detail account Row 

 
E.G: 
 
Enter the desired information into the Row 499701 - PY Exp in Current FY. 
Column FY16 YearTotal Budget Agency Request field. Enter "3000". 

9. Click the File menu. 
 

10. Click the Save menu. 

 
11. A message dialog box displays: "The data has been saved" 

 
Click the OK button. 

 
12. Complete the "Other Revenue Transactions" Task 

 
Click the Complete option. 
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Step Action 
13. The Operational Revenue Planning Tasks are now complete 

 
Log off [As needed] 
 
Click the File menu. 

 
14. Click the Log Off menu. 

 
15. Click the Yes button. 

 
16.  

End of Procedure. 

Operational Expense Planning 

1.19 - Plan Statewide Program Expenses 
In this topic you will add a new program and enter expenses for a program. The user will be able 
to review the expenses entered in multiple views.  

Procedure 
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Step Action 
1. [Note: If you have not logged off, skip to step 9] 

 
To begin using the application, we must first Log On. 
 
The user name is not case-sensitive. 
 
Enter the desired information into the field. Enter "<Username>". 

2. Enter the desired information into the field. Enter "<Password>". 
3. Click the Log On button. 

 
4. In order to open up the SOKPLAN application the following steps must be 

completed: 
 
Click the Navigate menu. 

 
5. Click the Applications menu. 

 
6. Click the Planning menu. 

 
7. Click the SOKPLAN menu. 

 
8. Navigate to the Plan Agency Expenditure button: 

 
Click the Plan Agency Expenditure Action button. 

 
9. Navigate to the Plan Agency Expenditure 

 
Click the Plan Agency Expenditure Expand button. 

 
10. Navigate to "Plan Statewide Program Expenses" 

 
Click the Plan Statewide Program Expenses object. 
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Step Action 
11. Adjust View for Form  

 
Pages drop downs are : 
Entity : < Select Desired DeptID>, Operating Unit: <Select Desired OU_PRD>, 
GL Account: <Select Total Expense Account '5 - expenditures'> 
 
For E.g. Entity: 26500_0100001 (Administrative Services), Operating Unit: 
26500_NoOPR_NoPRD, Account: '5' 
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Step Action 
12. Click the Entity dropdown button to activate the menu. 

 
13. Enter the desired information into the Member field. Enter "34500". 
14. Click the 7-digit department list item:  

 
E.G.: 
 
Click the 34500_21000001 - Transit list item. 

 
15. Click the Go button. 

 
16. Add Statewide Program  

 
Right-click the current year column header 
 
E.g.: 
 
Right-click the FY16 column header. 

 
17. Click the 1. Add New Statewide Program list item. 
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Step Action 
18. Provide Members 

 
Click the *Select Program Member Selector button. 

 
19. Click the desired program list item:  

 
E.G. 
  
Click the EWDCAFD00000023 list item. 

20. Click the Add button. 
 

21. Click the OK button. 

 
22. -Click on Member Selector icon against "Select Class Fund Values" and select 1 or 

more applicable Class Fund Values  
 
Click the *Select Class Fund Member Selector button. 

 
23. Click the desired class fund list item:  

 
E.G. 
  
Click the 34500_10006 list item. 

24. Click the Add button. 
 

25. Click the OK button. 

 
26. Click the Launch button. 

 
27. "LI_Add Program Budget was successful" window appears and a new row is 

created in the form 
 
Click the OK button. 

 
28. Plan Program Expenses 

 
Right-click the EWDCAFD00000023 - Parental Investment row header. 

 
29. Click the 2. Plan Program Expenses list item. 
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Step Action 
30. Provide Program Expenses 

-Expand the row "5 - Expenditures" by clicking on the "Drill Expand" button on that 
row 
 
-Enter data against multiple lowest level GL Accounts. For E.g. '5200001' 
 
Click the 5 Drill Expand button. 

 
31. Click the 52 - Travel Expand button. 

 
32. Click the 521 - Travel - Reimbursements Expand button. 

 
33. Enter the desired information into the select detail account Row 

 
E.G.: 
 
Enter the desired information into the Row 521310 - Travel Reimb.-Non-State 
Empls. Column Budget FY16 YearTotal field. Enter "10000". 

34. Enter the desired information into the select detail account Row 
 
E.G.: 
 
Enter the desired information into the Row 521260 - Out-of-State Lodging. 
Column Budget FY16 YearTotal field. Enter "2000". 

35. Click the File menu. 
 

36. Click the Save menu. 

 
37. A message dialog box displays: "The data has been saved" 

 
Click the OK button. 

 
38. Navigate to Main Page 

 
Click the LineItem_11_Statewide Program Expenses link. 

 
39. Review Statewide Program Expenses 

-Review the data on the "Budget View by Accounts" form 
 
Click the Budget View by Accounts tab. 
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Step Action 
40. Review Statewide Program Expenses 

-Review "Budget View by Class Fund" form  
 
Click the Budget View by Class Funding tab. 

 
41. Review Statewide Program Expenses 

-Review "Budget View by Class Funding" form 
 
Complete the "Plan Statewide Program Expenses" Task 
 
Click the Complete option. 

 
42. Click the Next button. 

 
43.  

End of Procedure. 

1.20 - Plan Operational Expenses 
In this topic you will enter comments for variances in expenses.  

Procedure 
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Step Action 
1. Hide the View Pane 

 
Click the Collapse Pane button. 

 
 

 
 

Step Action 
2. Adjust View for Form (Select Summary level values in page drop downs) 

 
Pages drop downs are : 
Entity : < Select Desired DeptID>, Project: <Select Project ID>, Operating Unit: 
<Select Desired OU_PRD>, ClassFund: <Select Desired ClassFund>, Program: 
<Select Program> 
 
For E.g. Entity: 26500, Project: All_Project, Operating Unit: 
26500_OPR_PRODUCT, ClassFund: 26500_CF, Program: All_Program 
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Step Action 
3. Click the Entity dropdown button to activate the menu. 

 
4. Enter the desired information into the Member field. Enter "34500 ". 
5. Click the 34500 - Department of Transportation cell. 

 
6. Click the Project dropdown button to activate the menu. 

 
7. Click the All_Projects list item. 

 
8. Click the Operating Unit dropdown button to activate the menu. 

 
9. Enter the desired information into the Member field. Enter "34500_op". 
10. Click the desired operating unit/product combination:   

 
E.G.: 
 
Click the 34500_OPR_PRODUCT list item. 

 
11. Click the ClassFund list item. 

 
12. Enter the desired information into the Member field. Enter "34500_cf". 
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Step Action 
13. Click the desired roll up business unit:  

 
E.G.: 
 
Click the 34500_CF - Department of Transportation list item. 

 
14. Click the Program dropdown button to activate the menu. 

 
15. Enter the desired information into the Member field. Enter "all". 
16. Click the All_Program list item. 

 
17. Click the Go button. 

 
 

 
 

Step Action 
18. Use the horizontal Scroll Bar to scroll to the right to view the whole form 
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Step Action 
19. Enter comment 

-This form allows us to capture comments/explanations/assumptions which are 
resulting into major variances for the current year budget 
 
-To enter 'Comments', select the variance $ cell which needs to be explained 
 
Right-click the Red Variance in % cell. 

 
20. Click the Comments menu. 

 
21. Click the Actions menu. 

 
22. Click the Add menu. 

 
23. Enter the desired information into the field. Enter "This cell contains a variance.". 
24. Click the Add button. 

 
25. Click the Close button. 

 
26. Complete the "Plan Operating Expenses" Task 

 
Click the Complete option. 
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Step Action 
27. Click the Next button. 

 
28.  

End of Procedure. 

1.20A - DHS Planning assumptions for Disbursing Funds (Only for DHS 
users) 
In this topic you will allow a DHS user to enter split percentages between State and Federal 
funding for Cost Pools and Department ID. 

Procedure 
 
 

 
 

Step Action 
1. To begin using the application, we must first Log On. 

 
The user name is not case-sensitive. 
 
Enter the desired information into the User Name: field. Enter "<username>". 

2. Enter the desired information into the Password: field. Enter "<Password>". 
3. Click the Log On button. 
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Step Action 
4. In order to open up the SOKPLAN application the following steps must be 

completed: 
 
Click the Navigate menu. 

 
5. Click the Applications menu. 

 
6. Click the Planning menu. 

 
7. Click the SOKPLAN menu. 

 
8. Click the DHS_Operational Planning object. 

 
9. Navigate to DHS_Operational Planning 

 
Click the Expand button. 

 
10. Navigate to "6. Plan Agency Expenditure" 

 
Click the Expand button. 

 
11. Click the Capture Planning Assumptions for Disbursing Funds object. 

 
12. If the View Pane is open, click the "Collapse Pane" button to hide it 

 
Click the Collapse Pane button. 

 
13. Adjust View for Form (Select lowest level values in page drop downs) 

 
Pages drop downs are : 
ClassFund : < Select Desired ClassFund> (DHS Disbursing ClassFunds) 
 
For E.g. Entity: 83000_20000 - Grants and Donations 
 
Click the ClassFund button. 

 
14. Click the 83000_200000: 83000_20000 - Grants And Donations cell. 

 
15. Click the Go button. 
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Step Action 
16. Enter Split % by Cost Pool 

 
-Click on the 'Split by Department ID' tab below ClassFund page dropdown 
 
1. "LineItem_15_DHS_Assumptions" form will appear 
Form Rows are : 
<DHS Agency_Department IDs> and <830_NoLOC> 
 
Form Columns are : 
-Q1, Q2, Q3 and Q4 break up of current Budget Year 
-DHS_State_Share % input column 
-System Computed columns: DHS_Federal_Share % (100% - DHS_State_Share %) 
and DHS_Total% (100%) 
 
2. Enter a DHS_State_Share % value (between 0 and 100) under Q1, Q2, Q3 and 
Q4 against a Department ID (83000_2100 - Children & Family Services) row 
 
3.Click the "Save" button in the top left corner of the webpage  
 
4. Verify computed values of DHS_Federal_Share % and DHS_Total% 
 
5. Repeat this for the remaining Department ID rows as required 
 
Enter the desired information into the 830_139/Q1/DHS_State Share % field. 
Enter "20". 

17. Enter the desired information into the 830_139/Q2/DHS_State Share % field. 
Enter "30". 

18. Navigate to Q3 and Q4 columns 
 
Press the left mouse button over the scrollbar and drag the mouse to the desired 
location. 

19. Enter the desired information into the 830_139/Q3/DHS_State Share % field. 
Enter "40". 

20. Enter the desired information into the 830_139/Q4/DHS_State Share % field. 
Enter "60". 

21. Click the File menu. 

 
22. Click the Save menu. 

 
23. Enter Split % by Department ID 

-Click on the 'Split by Department ID' tab below ClassFund page dropdown 
 
Click the Split by Department ID tab. 
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Step Action 
24. 1. "LineItem_15_DHS_Assumptions" form will appear 

Form Rows are : 
<DHS Agency_Department IDs> and <830_NoLOC> 
 
Form Columns are : 
-Q1, Q2, Q3 and Q4 break up of current Budget Year 
-DHS_State_Share % input column 
-System Computed columns: DHS_Federal_Share % (100% - DHS_State_Share %) 
and DHS_Total% (100%) 
 
2. Enter a DHS_State_Share % value (between 0 and 100) under Q1, Q2, Q3 and Q4 
against a Department ID (83000_2100 - Children & Family Services) row 
 
3.Click the "Save" button in the top left corner of the webpage  
 
4. Verify computed values of DHS_Federal_Share % and DHS_Total% 
 
5. Repeat this for the remaining Department ID rows as required 
 
 
Enter the desired information into the 83000_2101 - CWS 
HOTLINE/Q1/DHS_State Share % field. Enter "10". 

25. Enter the desired information into the 830_NoLOC/Q2/DHS_State Share % field. 
Enter "20". 

26. Navigate to Q3 and Q4 columns 
 
Press the left mouse button over the scrollbar and drag the mouse to the desired 
location. 

27. Enter the desired information into the 830_NoLOC/Q3/DHS_State Share % field. 
Enter "30". 

28. Enter the desired information into the 830_NoLOC/Q4/DHS_State Share % field. 
Enter "40". 

29. Click the File menu. 

 
30. Click the Save menu. 

 
31. Complete the "Capture Planning Assumptions for Disbursing Funds" Task 

 
Click the Complete option. 

32. Click the Next button. 
 

33.  
End of Procedure. 
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1.20B - DHS Expense Planning for Disbursing Funds (Only for DHS users) 
In this topic you will allow a DHS user to enter expenses and display the correct splits based on 
percentages entered in the previous script.  

Procedure 
 
 

 
 

Step Action 
1. Plan Expenses for Location Codes 

 
Adjust View for Form (Select lowest level values in page drop downs) 
 
Pages drop downs are : 
Entity: < Select Desired Department ID>, Program: < Select Desired Program ID 
>, ClassFund: <Select Desired ClassFund>, Project: <Select Desired DHS 
location code> 
 
For E.g. Entity: 83000_2101 - CWS Hotline, No_Program, 83000_20000 - Grants 
and Donations, 830_30401 - Beaver Co (04) County Distribution (Location code 
under the Cost Pool 830_101) 
 
Click the Entity dropdown button to activate the menu. 

 
2. E.g.: 

 
Click the 83000_2101 - CWS HOTLINE list item. 
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Step Action 
3. Click the Program dropdown button to activate the menu. 

 
4. Enter the desired information into the Member field. Enter "no". 
5. Click the No Program list item. 

 
6. Click the ClassFund dropdown button to activate the menu. 

 
7. E.g.: 

 
Click the 83000_20000 - Grants And Donations list item. 

 
8. Click the Project dropdown button to activate the menu. 

 
9. Select a location code that matches the sub account  

 
E.g (this one does not): 
 
Click the 830_30401 - BEAVER CO )04) COUNTY DISTRIBUTION list item. 

 
10. Click the Go button. 

 
11. Enter Expenses  

-Expand the Account row 5 by clicking on the '+' sign next to the account 
-Go the lowest level 6 digit Account by expanding the required account rows 
-Enter yearly Expenditure value against a relevant Account code under No_OU 
column 
 
Click the 52 - TRAVEL Expand button. 

 
12. Click the 521 - Travel - Reimbursements Drill Expand button. 

 
13. Enter the desired information into the 521110 - In-State Mileage-Motor Vehicle 

No_OU field. Enter "22000". 
14. Enter the desired information into the 521120 - In-State Meals-Subsistence Exp 

No_OU field. Enter "23000". 
15. Click the File menu. 

 
16. Click the Save menu. 

 
17. Click the DHS_Total $ Drill Expand button. 
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Step Action 
18. Click the Save button. 

 
19. [NOTE: If "Save" feature ran the rule, skip this step] 

 
Launch the "LI_DHS_Split" rule 
 
Click the Launch button. 

 
20. Message dialog box displays reading "The data has been saved.  Rule was run 

successfully" 
 
Click the OK button. 

 
21. Review Expense Split  

-With data save action, system will compute DHS_State_Share $ and DHS_Federal 
Share $ based on inputs provided in DHS Planning Assumptions form 
 
-To Verify the computation, expand 'DHS_Total $' column by clicking on the '+' sign 
-Q1 DHS_State $ = Q1 -> DHS_State_Share % (Location's Parent Cost Pool) * Q1 
-> No_OU Value User Input 
-Q2 DHS_State $ = Q2 -> DHS_State_Share % (Location's Parent Cost Pool) * Q2 
-> No_OU Value User Input 
-Q3 DHS_State $ = Q3 -> DHS_State_Share % (Location's Parent Cost Pool) * Q3 
-> No_OU Value User Input 
-Q4 DHS_State $ = Q4 -> DHS_State_Share % (Location's Parent Cost Pool) * Q4 
-> No_OU Value User Input 
 
-Yearly DHS_State $ = Q1 DHS_State $ + Q2 DHS_State $ + Q3 DHS_State $ + 
Q4 DHS_State $  
 
-At any of the Period member, DHS_Total $ = No_OU value 
 
-At any of the Period member, DHS_Federal $ = DHS_Total $ - DHS_State $ 
 
Click the DHS_Total $ Drill Expand button. 

 
22. Click the YearTotal Expand button. 

 
23. Reload "Plan Expenses for Disbursing Funds" Page by opening the View Pane 

 
Click the Restore Pane button. 

 
24. Click the DHS_Operational Planning object. 
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Step Action 
25. Click the 6. Plan Agency Expenditure object. 

 
26. Click the Plan Expenses for Disbursing Funds object. 

 
27. The page has now been reloaded.  Hide the View Pane 

 
Click the Collapse Pane button. 

 
28. Plan Expenses for No Location Code 

 
Adjust View for Form (Select lowest level values in page drop downs) 
 
Pages drop downs are : 
Entity: < Select Desired Department ID>, Program: < Select Desired Program ID 
>, ClassFund: <Select Desired ClassFund>, Project: <Select Desired DHS 
location code> 
 
For E.g. Entity: 83000_2100 - Children & Family Services, No_Program, 
83000_20000 - Grants and Donations, 830_NoLOC 
 
Click the Entity dropdown button to activate the menu. 

 
29. Enter the desired information into the Member field. Enter "83000_2105". 
30. Click the 83000_2105 - 4E ADOPTION SUBSIDY list item. 

 
31. Click the Project button. 

 
32. Enter the desired information into the Member field. Enter "830_no". 
33. Click the 830_NoLOC list item. 

 
34. Click the Go button. 

 
35. Enter Expenses  

-Expand the Account row 5 by clicking on the '+' sign next to the account 
-Go the lowest level 6 digit Account by expanding the required account rows 
-Enter yearly Expenditure value against a relevant Account code under No_OU 
column 
 
Click the 51 - PERSONAL SERVICES Drill Expand button. 

 
36. Click the 511 - Salary Expense Drill Expand button. 
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Step Action 
37. Enter the desired information into the 511120 - Sals-Regular Pay Legislature 

No_OU field. Enter "10000". 
38. Enter the desired information into the 511130 - Sals-Regular Pay Legislature 

No_OU field. Enter "20000". 
39. Click the File menu. 

 
40. Click the Save menu. 

 
41. Review Expense Split  

-With data save action, system will compute DHS_State_Share $ and DHS_Federal 
Share $ based on inputs provided in DHS Planning Assumptions form 
 
-To Verify the computation, expand 'DHS_Total $' column by clicking on the '+' sign 
-Q1 DHS_State $ = Q1 -> DHS_State_Share %  (Department ID and NoLOC 
combination) * Q1 -> No_OU Value User Input 
-Q2 DHS_State $ = Q2 -> DHS_State_Share % (Department ID and NoLOC 
combination) * Q2 -> No_OU Value User Input 
-Q3 DHS_State $ = Q3 -> DHS_State_Share % (Department ID and NoLOC 
combination) * Q3 -> No_OU Value User Input 
-Q4 DHS_State $ = Q4 -> DHS_State_Share % (Department ID and NoLOC 
combination) * Q4 -> No_OU Value User Input 
 
-Yearly DHS_State $ = Q1 DHS_State $ + Q2 DHS_State $ + Q3 DHS_State $ + 
Q4 DHS_State $  
 
-At any of the Period member, DHS_Total $ = No_OU value 
 
-At any of the Period member, DHS_Federal $ = DHS_Total $ - DHS_State $ 
 
Click the DHS_Total $ Drill Expand button. 

 
42. Click the YearTotal Drill Expand button. 
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Step Action 
43. Review the data on the form using the scroll bar when necessary 
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Step Action 
44. Complete the "Plan Expenses for Disbursing Funds" Task 

 
Click the Complete option. 

45. Click the Task List Home button. 
 

46. Click the Log Off object. 
 

47. Click the Yes button. 

 
48.  

End of Procedure. 

1.21 - Identify uses of carryover and cash needs in the current year budget 
In this topic you will enter answers for the questions regarding carryover/cash needs. 

Procedure 
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Step Action 
1. Adjust View for Form (Select lowest level values in page drop downs) 

 
Page drop downs are : 
Entity : < Select Desired DeptID> 
 
For E.g.: 
Entity: 26500_0100001 (Administrative Services) 
 
Click the Entity dropdown button to activate the menu. 

 
2. Enter a valid value 

 
E.G.: 
 
Enter the desired information into the Member field. Enter "34500_21". 

3. Click the 34500_2100001 - Transit list item. 
 

4. Click the Go button. 
 

5. Provide Carry over and cash needs details 
-Navigate to the  "Response" form 
-Enter text in the "Response" form corresponding to the questions in the "Input 
Required" form 
 
Enter the desired information into the CCN2 Response: field. Enter "This field is 
where you enter comments.". 

6. Click the File menu. 

 
7. Click the Save menu. 

 
8. Information dialog box displays reading "The data has been saved" 

 
Click the OK button. 

 
9. Complete the "Identify uses of carryover and cash needs in the current year budget" 

Task 
 
Click the Complete option. 

10. Click the Next button. 
 

11.  
End of Procedure. 
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1.22 - Provide Federal Program overview 
In this topic you will add answers to the questions regarding grants.  

Procedure 
 
 

 
 

Step Action 
1. Click the Next button. 

 
2. Adjust View for Form (Select lowest level values in page drop downs) 

 
Pages drop downs are : 
Entity : < Select Desired DeptID>, CFDA: <Select Desired CFDA> 
 
For E.g.: 
 Entity: 26500_0100001 (Administrative Services), CFDA: 100690000 
 
Click the Entity button. 

 
3. Click the desired 7-digit department Member cell.  

 
E.g. 
 
Click the Member cell. 
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Step Action 
4. Click the Go button. 

 
5. Provide Federal Program overview 

-Navigate to the  "Response" form 
-Enter text in the "Response" form corresponding to the questions in the "Input 
Required" form 
 
Enter the desired information into the FP4 Response: field. Enter "There are no 
limits for this program". 

6. Enter the desired information into the FP5 Response: field. Enter "5 years". 
7. Click the File menu. 

 
8. Click the Save menu. 

 
9. Information dialog box displays reading "The data has been saved" 

 
Click the OK button. 

 
10. Complete the "Provide Federal Program Overview" Task 

 
Click the Complete option. 

11. Click the Next button. 
 

12.  
End of Procedure. 

1.23 - Provide Federal Program details 
In this topic you will enter revenue values for grants based on multiple revenue accounts.   

Procedure 
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Step Action 
1. Adjust View for Form (Select lowest level values in page drop downs) 

 
Pages drop downs are : 
Entity : < Select Desired DeptID>, CFDA: <Select Desired CFDA>, ClassFund: 
<Select desired ClassFund> 
 
For E.g.: 
 Entity: 26500_0100001 (Administrative Services), CFDA: 100690000, ClassFund: 
26500_10000 
 
Click the Entity dropdown button to activate the menu. 

 
2. Enter a valid value 

 
E.G.:  
 
Enter the desired information into the Member field. Enter "34500_21". 

3. Click the desired 7-digit department:  
 
E.G.: 
   
Click the 34500_2100001 - Transit cell. 

 
4. Click the ClassFund button. 
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Step Action 
5. Click the desired class fund:  

 
E.G.: 
 
Click the 34500_40000 - County Bridge Revolving Fund list item. 

 
6. Click the Go button. 

 
7. Provide Federal Program details 

-Enter data in the current year budget cells  
-'Total Expenditure' and 'Total Pass Thrus' will be calculated based on inputs 
provided in above cells 
 
Enter the desired information into the Exp - State Dollars Budget field. Enter 
"2000". 

8. Enter the desired information into the Exp - Federal Dollars Budget field. Enter 
"4000". 

9. Enter the desired information into the Pass Thrus - State Dollars Budget field. 
Enter "1000". 

10. Enter the desired information into the Pass Thrus - Federal Dollars Budget field. 
Enter "3000". 

11. Click the File menu. 

 
12. Click the Save menu. 

 
13. Information dialog box displays reading "The data has been saved" 

 
Click the OK button. 

 
14. Click the Complete option. 
15. Click the Next button. 

 
16.  

End of Procedure. 

1.24 - Identify Federal Grants 
In this topic you will enter answers for the questions regarding Federal Programs. 

Procedure 
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Step Action 
1. To access the subtasks, click the "Next" button on the Main task "Identify Grants 

and Pass Through to Local Gov't and Non-profits" 
Click the Next button. 
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Step Action 

2. Adjust View for Form (Select lowest level values in page drop downs) 
 
Pages drop downs are : 
Entity : < Select Desired DeptID> , ClassFund: <Select Desired ClassFund>  
 
For E.g. Entity: 26500_0100001 (Administrative Services), ClassFund: 
26500_10000 
 
Click the Class Fund dropdown button to activate the menu. 

 
3. E.g. 

 
Click the 34500_10006 - To Hwy Const and Maint Fund cell. 

 
4. Click the Go button. 

 
5. Provide Grant Details 

-Navigate to the  "Response" form 
-Enter text in the "Response" form corresponding to the questions in the "Input 
Required" form 
 
Enter the desired information into the G1/Response: field. Enter "Description". 

6. Enter the desired information into the G2/Response: field. Enter "No". 
7. Enter the desired information into the G4/Response: field. Enter "Explain 

Administration". 
8. Enter the desired information into the G5/Response: field. Enter "Explain how 

rules are established". 
9. Click the File menu. 

 
10. Click the Save menu. 

 
11. A message appears reading "The data has been saved." 

 
Click the OK button. 

 
12. Complete the "Identify Grants" Task 

 
Click the Complete option. 

13. Click the Next button. 
 

14.  
End of Procedure. 



 

 Page 93 

1.25 - Provide Grants details 
In this topic you will enter expenses based on federal programs and totals in in Total 
Expenditures and Total Pass Thru would be calculated correctly.  

Procedure 
 
 

 
 

Step Action 
1. Adjust View for Form (Select lowest level values in page drop downs) 

 
Pages drop downs are : 
Entity : < Select Desired DeptID> , ClassFund: <Select Desired ClassFund>, 
CFDA: <Select Desired CFDA>, Operating Unit: <Select Desired OU_PRD>, 
Program: <Select Program> 
 
For E.g. Entity: 26500_0100001 (Administrative Services), ClassFund: 
26500_10000, CFDA: 100690000, Operating Unit: 26500_NoOPR_NoPRD, 
Program: No_Program 
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Step Action 
2. Click the Entity dropdown button to activate the menu. 

 
3. E.g.: 

 
Click the 34500_6800001 - Highway cell. 

 
4. Click the ClassFund dropdown button to activate the menu. 

 
5. E.g.: 

 
Click the 34500_10006 - To Hwy Const and Maint Fund cell. 

 
6. Click the CFDA button. 

 
7. E.g.: 

 
Click the 100690000 - Conservation Reserve Program cell. 

 
8. Click the Go button. 

 



 

 Page 95 

Step Action 
9. Provide Grant Details 

-Expand a row by clicking on the "Drill Expand" button on that row 
-Enter data in the fields under the "FY16" column 
 
E.g.: 
 
Click the 4511 - Insur.&Other Reimb.for Damages Expand button. 

 
10. E.g.: 

 
Enter the desired information into the FY16 / 451101 - Insur.&Other Reimb.for 
Damages Expand field. Enter "15000". 

11. Click the File menu. 

 
12. Click the Save menu. 

 
13. Provide Additional Details 

-Right-click the cell with newly entered revenue data 
 
Right-click the Budget cell. 

 
14. Click the Provide Grant Details menu. 

 
15. Enter the desired information into the Award Number\FY16 field. Enter "123456". 
16. Enter the desired information into the Award Period Begins/FY16 field. Enter 

"8/5/14". 
17. Click the File menu. 

 
18. Click the Save menu. 

 
19. A message appears reading "The data has been saved." 

 
Click the OK button. 

 
20. Click the Multi-Year Grant Planning tab. 
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Step Action 
21. In the Multi-Year Grant Planning Tab 

-Capture 'Total Funded Amount', 'State Share %', 'Amount Federal Funds 
Received/Invoiced', and 'Amount Federal Funds Remaining' for Current Budget 
Year as well as future years based on tenure of the Grant 
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Step Action 
22. Click the Revenue_12_Grants Revenue link. 

 
23. E.g.: 

 
Click the 4511 - Insur.&Other Reimb.for Damages Expand button. 

 
 

 
 

Step Action 
24. Review the data at the lower level 
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Step Action 
25. Complete the "Provide Grants Details" Task 

 
Click the Complete option. 

26. Click the Next button. 
 

27.  
End of Procedure. 

1.26 - Agency Property Maintenance Summary 
In this topic you will answer questions regarding property maintenance. 

Procedure 
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Step Action 
1. Adjust View for Form (Select lowest level values in page drop downs) 

 
Pages drop downs are : 
Entity : < Select Desired DeptID> 
 
For E.g.: 
Entity: 26500_0100001 (Administrative Services) 
 
Click the Entity dropdown button to activate the menu. 

 
2. Enter a valid value 

 
E.G.: 
 
Enter the desired information into the Member field. Enter "34500_2100001". 

3. Click the desired 7-digit department: 
 
E.G.: 
   
Click the 34500_2100001 - Transit cell. 

 
4. Click the Go button. 
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Step Action 
5. Provide Agency Property Maintenance Summary 

-Navigate to the  "Response" form 
-Enter text in the "Response" form corresponding to the questions in the "Input 
Required" form 
 
Enter the desired information into the PM2 Response: field. Enter "Enter 
Additional Comments here.". 

6. Click the File menu. 

 
7. Click the Save menu. 

 
8. Information dialog box displays reading "The data has been saved" 

 
Click the OK button. 

 
9. Complete the "Agency Property Maintenance Summary" Task 

 
Click the Complete option. 

10. Click the Next button. 
 

11.  
End of Procedure. 

1.27 - Plan Property Maintenance Expenses 
In this topic you will enter information regarding property maintenance. The Total Assets and 
Total Expenditures total will be added correctly. 

Procedure 
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Step Action 
1. Adjust View for Form (Select lowest level values in page drop downs) 

 
Pages drop downs are: 
Entity : < Select Desired DeptID> 
 
For E.g.: 
 Entity: 26500_0100001 (Administrative Services) 
 
Click the Entity dropdown button to activate the menu. 

 
2. Enter a valid value 

 
E.G.: 
  
Enter the desired information into the Member field. Enter "34500_2100001". 

3. Click the desired 7-digit department list item: 
 
E.G.: 
 
Click the 34500_2100001 - Transit list item. 

 
4. Click the Go button. 
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Step Action 
5. Provide Property Maintenance Expenses 

-Enter data in the current budget year columns 
-'Total Assets' and 'Total Expenditure' rows will summarize numbers entered in the 
above rows 
 
Enter the desired information into the Assets - Equipment Budget field. Enter 
"1000". 

6. Enter the desired information into the Assets - Buildings Budget field. Enter 
"2000". 

7. Enter the desired information into the Assets - Other Property Budget field. Enter 
"2000". 

8. Enter the desired information into the 541110 - Office Furniture & Equipment 
Budget field. Enter "2000". 

9. Enter the desired information into the 547110 - Hgwy,Bridge Constr.-Contracts 
Budget field. Enter "4000". 

10. Click the File menu. 

 
11. Click the Save menu. 

 
12. A message dialog box displays: "The data has been saved" 

 
Click the OK button. 

 
13. Complete the "Plan Property Maintenance Expenses" Task 

 
Click the Complete option. 

14. Click the Next button. 
 

15.  
End of Procedure. 

1.28 - Identify Legislation Needs 
In this topic you will answer questions regarding legislation needs. 

Procedure 
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Step Action 
1. Adjust View for Form (Select lowest level values in page drop downs) 

 
Pages drop downs are : 
Entity : < Select Desired DeptID> 
 
For E.g.: 
 Entity: 26500_0100001 (Administrative Services) 
 
Click the Entity dropdown button to activate the menu. 

 
2. Enter a valid value 

 
E.G.: 
 
Enter the desired information into the Member field. Enter "34500_2100001". 

3. Click the desired 7-digit department list item:  
 
E.G.:  
 
Click the 34500_2100001 - Transit list item. 

 
4. Click the Go button. 
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Step Action 
5. Identify Legislation Needs 

-Navigate to the  "Response" form 
-Enter text in the "Response" form corresponding to the questions in the "Input 
Required" form 
 
Enter the desired information into the LN2 Response: field. Enter "Provide a 
description for change here". 

6. Click the File menu. 

 
7. Click the Save menu. 

 
8. A message dialog box displays: "The data has been saved" 

 
Click the OK button. 

 
9. Complete the "Identify Legislation Needs" Task 

 
Click the Complete option. 

10. Click the Next button. 
 

11.  
End of Procedure. 

1.29 - Operational Decision Package 
In this topic you will create a decision package, enter the information, and promote to the 
approver. 

Procedure 
 
 



 

 Page 105 

 
 

Step Action 
1. [Note: If you have not logged off, skip to step 9] 

 
To begin using the application, we must first Log On. 
 
The user name is not case-sensitive. 
 
Enter the desired information into the User Name: field. Enter "JDoe_N". 

2. Enter the desired information into the Password: field. Enter "Password". 
3. Click the Log On button. 

 
4. In order to open up the SOKPLAN application the following steps must be 

completed: 
 
Click the Navigate menu. 

 
5. Click the Applications menu. 

 
6. Click the Planning menu. 

 
7. Click the SOKPLAN menu. 
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Step Action 
8. [NOTE: Refer to your UAT Accessibility Document instructions (Creating a 

Document to Attach in Hyperion) to  set up a document for completing the next 
steps.  If you have created a document on your desktop already, please continue to 
step 10.] 

9. Use the vertical scroll bar to navigate to the "Operational Decision Package" Task 
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Step Action 
10. Navigate to the Action button corresponding to "Operational Decision Package" 

 
Click the Action button. 

 
11. Hide the View Pane (if not already hidden) 

 
Click the Collapse Pane button. 

 
12. Create Decision Package 

-Click the "Action" menu located below the "Scenario" list box 
  
Click the Action menu. 

 
13. Click the Create Decision Package menu. 
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Step Action 
14. Provide Information for New Decision Package 

-Enter Name in the "Name" field 
-Enter Description in the "Description" field 
-Choose a desired Rank using the arrows on  the "Rank" list box 
-Select "Include" from the "Budget Impact" drop down list box 
-Make no changes to "Scenario" field 
-Make no changes to "Version" field 
 
Enter the desired information into the Decision Package Name field. Enter 
"34500_New Decision Package". 

15. Enter the desired information into the Description field. Enter "This is a new 
decision package". 

16. Select a desired rank for the decision package by click the "Increment" button 
 
Click the increment button next to the Rank field 
 
E.g.: 
 
Click the increment button. 

 
17. Select Owner Entity for Decision Package 

-Click the "Select Members" button to the right of the "Owner Entity" field 
 
Click the Owner Entity Select Members button. 

 
18. Click the Expand button next to your five-digit business unit. 

 
E.g: 
 
Click the 34500 Expand button. 

 
19. Click the Expand button next to your division.  

 
E.g: 
 
Click the 34500_20 Expand button. 

 
20. Select the 7-digit department list item.  

 
E.g. 
  
Click the 34500_2000001 list item. 

 
21. Click the Add button. 
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Step Action 
22. Submit Owner Entity selection 

-Click the "Ok" button in the bottom right corner of the "Member Selection" window 
 
Click the OK button. 

 
23. Click the Justification tab. 

 
 

 
 

Step Action 
24. Answer the Justification Questions 

-Answer all the Justification Questions by scrolling through the dialog box for each 
question 
-Repeat this step after each question until all questions have been answered 
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Step Action 
25. Enter the desired information into the Question 1 field. Enter "Mandatory". 
26. Use the vertical scroll bar to scroll to Question 2 
27. Enter the desired information into the Question 2 field. Enter "Mandatory". 
28. Use the vertical scroll bar to scroll to Question 3 
29. Enter the desired information into the Question 3 field. Enter "Mandatory". 
30. Use the vertical scroll bar to scroll to Question 4 
31. Enter the desired information into the Question 4 field. Enter "Mandatory". 
32. Use the vertical scroll bar to scroll to Question 5 
33. Enter the desired information into the Question 5 field. Enter "Mandatory". 
34. Use the vertical scroll bar to scroll to Question 6 
35. Enter the desired information into the Question 6 field. Enter "Mandatory". 
36. Use the vertical scroll bar to scroll to Question 7 
37. Enter the desired information into the Question 7 field. Enter "Mandatory". 
38. Use the vertical scroll bar to scroll to Question 8 
39. Enter the desired information into the Question 8 field. Enter "Mandatory". 
40. Use the vertical scroll bar to scroll to Question 9 
41. Enter the desired information into the Question 9 field. Enter "Mandatory". 
42. Use the vertical scroll bar to scroll to Question 10 

Press the left mouse button over the scrollbar and drag the mouse to the desired 
location. 
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Step Action 
43. Enter the desired information into the Question 10 field. Enter "Mandatory". 
44. Use the vertical scroll bar to scroll to Question 11 
45. Enter the desired information into the Question 11 field. Enter "Mandatory". 
46. Use the vertical scroll bar to scroll to Question 12 
47. Enter the desired information into the Question 12 field. Enter "Mandatory". 
48. Use the vertical scroll bar to scroll to Question 13 
49. Enter the desired information into the Question 13 field. Enter "Mandatory". 
50. Use the vertical scroll bar to scroll to Question 14 
51. Enter the desired information into the Question 14 field. Enter "Mandatory". 
52. Use the vertical scroll bar to scroll to Question 15 
53. Enter the desired information into the Question 15 field. Enter "Mandatory". 
54. Use the vertical scroll bar to scroll to Question 16 
55. Enter the desired information into the Question 16 field. Enter "Mandatory". 
56. Use the vertical scroll bar to scroll to Question 17 
57. Enter the desired information into the Question 17 field. Enter "Mandatory". 
58. Use the vertical scroll bar to scroll to Question 18 
59. Enter the desired information into the Question 18 field. Enter "Mandatory". 
60. Use the vertical scroll bar to scroll to Question 19 
61. Enter the desired information into the Question 19 field. Enter "Mandatory". 
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Step Action 
62. Use the vertical scroll bar to scroll to Question 20 
63. Enter the desired information into the Question 20 field. Enter "Mandatory". 
64. Click the Summary tab. 

 
 

 
 

Step Action 
65. -Use the scroll bar to scroll through the window to verify all questions have been 

answered 
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Step Action 
66. Create the Decision Package 

 
Click the Finish button. 
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Step Action 
67. Navigate to the top of the page 

 
Click the ExploreMode button. 

 
68. Double-click the Budget Supporting Documents tree item. 

 
69. Select the 5 digit agency in the "Content Area" 

 
E.g.: 
 
Double-click the 34500 tree item. 

 
70. Navigate to the View Pane 

 
Right-click the 34500 tree item. 

 
71. Click the Import menu. 

 
72. Click the File... menu. 

 
73. Click the Browse... button. 
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Step Action 
74. [NOTE: Selecting the note depends on the location where you saved the file.  Refer 

to the instructions] 
 
Click the 34500_Operating Decision Package.docx list item. 

75. Click the Open object. 

 
 or Press [Alt+O]. 
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Step Action 
76. Click the Next button. 

 
77. [NOTE: Advanced Options are optional] 

Click the Next button. 

 
78. Click the Groups tab. 

 
79. Click in the begin with field. 

 
80. Enter the desired information into the begin with field. Enter "li_grp_34500". 
81. Click the Update List button. 

 
82. Click the Update List button. 

 
83. Enter the desired information into the begin with field. Enter "li_grp_all_agencies". 
84. Click the Update List button. 

 
85. Click the Update List button. 
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Step Action 
86. Navigate to the Access column 

 
Once in the Access column click "invisible" field located next to the word "Group" 
 
Click the Group tree item. 

 
87. Click the Modify list item. 

 
88. Modify Access for the second group 

Click the Group tree item. 
 

89. Click the Modify list item. 
 

90. Click the Finish button. 

 
91. Click the SOKPLAN tab. 

 
92. Click the Decision Package you just created to highlight it.  

 
E.g: 
 
Click the Decision Package cell. 

 
93. Add Notes/Attachments 

 
Locate the four tabs below the decision package list. These four tabs are:  Budget 
Requests, Approval Status, Justification, and Notes and Attachments. 
 
Click the Notes and Attachments tab. 

 
94. Click the Action menu. 

 
95. Click the Create Note menu. 

 
96. Enter Note 

-enter text in the textbox 
-uncheck the "Mark as Private" checkbox 
 
Enter the desired information into the Note field. Enter "Please review Decision 
Package". 
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Step Action 
97. De-select the Mark as Private (it will be selected by default) 

 
Click the Mark as Private option. 

98. Click the Save button. 
 

99. Click the Attachments tab. 

 
100. Click the Action menu. 

 
101. Click the Create Attachment menu. 

 
102. In the Add Attachment box: 

 
Enter an Attachment Title 
 
E.g.: 
 
Enter the desired information into the Attachment Title field. Enter "New 
Attachment". 

103. Click the Browse to Workspace graphic. 

 
104. Double-click the Budget Supporting Documents tree item. 

 
105. Use the vertical scroll bar to find the appropriate 5-digit agency folder. 

 
E.g.: 
 
Double-click the 34500 tree item. 

 
106. Double-click the 34500_Operating Decision Package.docx tree item. 

 
107. Uncheck the Mark as Private option (checked by default) 

 
Click the Mark as Private option. 

108. Click the Save button. 
 

109. Create a New Budget Request 
 
Click the Budget Requests tab. 

 



 

 Page 119 

Step Action 
110. Click the Action menu. 

 
111. Click the Create Budget Request menu. 

 
 

 
 

Step Action 
112. Enter Information for New Budget Request 

-Enter text in the "Name" field 
-Enter text in the "Description" field 
-Select a rank using the arrows in the "Rank" list box 
-Select "Include" for the "Budget Impact" list box 
-Make no changes to the "Owner Entity" field, it inherits DeptID from Decision 
Package 
-Select "Non Recurring" for the "Budget Type" 
-After all the questions are answered, click the "Summary" tab to review the 
answers 
-Click the "Finish" button in the bottom right corner of the "Create/Edit Budget 
Request" window 
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Step Action 
113. Enter the desired information into the Name field. Enter "34500_Budget Request 

1". 
114. Enter the desired information into the Description field. Enter "This is the 1st 

budget request for the operating decision package". 
115. Select a rank for the budget request that is 1 rank higher  

 
E.g. 1 to 2 
 
Click the increment button. 

 
116. Click the Budget Type list. 

 
117. Click the Non Recurring list item. 

 
118. Click the Summary tab. 

 
119. Click the Finish button. 
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Step Action 
120. Edit the newly created Budget Request 

-Click on the newly created Decision Package 
-Select the newly created Decision Package in the "Manage" tab 
-Select the newly created Budget Request in the "Budget Requests" tab at the bottom 
of the page 
-Click the "Action" list menu 
-Click "Edit Budget Request Data" 
 
Click the Action menu. 

 
121. Click the Edit Budget Requests Data menu. 

 
122. Click the Action menu. 

 
123. Click the Create Note menu. 

 
124. Enter Note 

-enter text in the textbox 
-uncheck the "Mark as Private" checkbox 
-click the "Save" button in the bottom right corner 
 
Enter the desired information into the Note field. Enter "This is the first budget 
request". 

125. De-select the Mark as Private Option (checked by default) 
 
Click the Mark as Private option. 

126. Click the Save button. 
 

127. Click the Attachments tab. 

 
128. Click the Action menu. 

 
129. Click the Create AttachmentCtrl+Shift+N menu. 

 
130. Select Attachment 

-enter text in the 2 textboxes 
-uncheck the "Mark as Private" checkbox 
-click the "Browse to Workspace" button 
 
Click in the Attachment Title field. 
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Step Action 
131. Enter the desired information into the Attachment Title field. Enter "budget 

request 1 attachment". 
132. Click the Browse to Workspace button. 

 
133. -select a file from list 

-click the "Ok" button 
-click the "Save" button in the bottom right corner 
 
Click the 34500_Operating Decision Package.docx tree item. 

 
134. Click the OK button. 

 
135. Click the Mark as Private option. 
136. Click the Save button. 

 
137. Provide information for the Data Collection Forms 

 
Click the Data Collection Forms tab. 

 
138. Add New Program Funding Source 

-Click the tab "New Program Funding Source" 
 
Adjust View for Form (Select lowest level values in page drop downs) 
 
Pages drop downs are : 
Program: < Select desired Program ID>, GL Account: <Select desired GL 
Account>, CFDA: <Select desired CFDA>, Operating Unit: <Select desired 
Opr_Product>, Entity: <Select desired Entity> 
 
For E.g.  
Program: No_Program, Account: 4511, CFDA: 100690000, Operating_Unit: 
26500_NoOPR_NoPRD, Entity: 26500_0100001 (Administrative Services) 
 
Click the New Program Funding Source tab. 

 
139. Navigate to the CDFA POV (3rd from the right) 

 
Click the CFDA dropdown button to activate the menu. 

 
140. Click the 970920000 - Repetitive Flood Claims cell. 
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Step Action 
141. Click the Go button. 

 
142. Right-click the row header. 

 
143. Right-click the row header. 

 
144. Click the Add_New_Class_Fund menu. 

 
145. Click the *Select Class Fund Values button. 

 
146. Click the All_Class_Funds Expand button. 

 
 

 
 

Step Action 
147. Use the scroll bar to navigate to the appropriate agency 

 
E.g.: 
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Step Action 
148. Click the 34500_CF Expand button. 
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Step Action 
149. Use the scroll bar to scroll to the appropriate fund 

 
 

 
 

Step Action 
150. Click the 34500_Appropriated button. 
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Step Action 
151. Use the scroll bar to navigate to the appropriate class fund 
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Step Action 
152. Click the 34500_10006 cell. 

 
153. Click the Add button. 

 
154. Click the OK button. 

 
155. Click the Launch button. 

 
156. A message displays reading "LI_Add Class FUnd was successful." 

 
Click the OK button. 

 
157. Enter data for the selected Class Fund (do not enter at "No Class Fund") 

 
E.g.: 
 
34500_10006 - To Hwy Const and Maint Fund 
 
Enter the desired information into the Budget field. Enter "1000". 

158. Click the Save button. 

 
159. A message displays reading "The data has been saved." 

 
Click the OK button. 

 
160. Click the New Program Expenditure tab. 
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Step Action 
161. New Program Expenses 

-Click the "New Program Expenses" tab 
 
Adjust View for Form (Select lowest level values in page drop downs) 
Pages drop downs are : 
Entity: <Select desired Entity>, Operating Unit: <Select desired Opr_Product>, 
Project: <Select desired Project>, Program: < Select desired Program ID>, 
ClassFund: <Select desired ClassFund> 
 
For E.g. Entity: 26500_0100001 (Administrative Services), Operating_Unit: 
26500_NoOPR_NoPRD, Project: No_Project, Program: No_Program, ClassFund: 
26500_10000 
 
-Expand the Account row by clicking on the "Drill Expand" button on the row "5" 
-Go to the lowest level of Account 
-Enter data in all the fields on the form 
-Click the "Save" button located on the Workspace toolbar 
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Step Action 
162. Click the ClassFund button. 

 
163. Select your desired class fund.  

 
E.g.:  
 
Click the 34500_10006 - To Hwy Const and Maint Fund list item. 

 
164. Click the Go button. 

 
165. Click the Expenditure Drill Expand button. 

 
166. Click the 52 - TRAVEL Drill Expand button. 

 
167. Click the 521 - TRAVE - Reimbursements Drill Expand button. 

 
168. Enter the desired information into the 521110 - In State Mileage-Motor Vehicle 

YearTotal field. Enter "2000". 
169. Enter the desired information into the 521120 - In-State Meals-Subsistence 

Exp/YearTotal field. Enter "3000". 
170. Enter the desired information into the 521130 - In-State Public 

Transp.ChargesYearTotal field. Enter "1000". 
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Step Action 
171. Click the File menu. 

 
172. Click the Save menu. 

 
173. A message box displays reading "The data has been saved.  Rule was run 

successfully" 
 
Click the OK button. 

 
174. Click the Decision Packages link. 

 
175. Click the Approval Status tab. 

 
176. Click the Planning Unit cell for the budget request for your department id. 

 
E.g.: 
 
Click the 34500_2000001 cell. 

177. Click the Actions menu. 

 
178. Click the Change Status menu. 

 
179. Promote Decision Package 

-Select "Promote" from the "Select Action" list menu 
-Select the first level reviewer (1 level above selected planning unit) in the "Select 
Next Owner" drop down list menu 
-Click the "Ok" button in the bottom right corner of the "Change Status" window 
 
Click the Select Next Owner list. 

 
180. Click the shared group item allowed.  

 
E.g.  
 
Click the PUHShared_Grp_34500 list item. 

 
181. Click the OK button. 

 
182. A message box displays reading "Change status submitted." 

 
Click the OK button. 
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Step Action 
183. Complete "Operational Decision Package" task 

 
Click the Complete option. 

184. Click the Next button. 
 

185.  
End of Procedure. 

1.30 - Aggregate Current Budgets 
In this topic you will access the job console with all the rules that were executed successfully will 
appear with the completion status. 

Procedure 
 
 

 
 

Step Action 
1. Launch the Business Rule 

 
Click the Launch button. 

 
2. Click the Member Selector button. 
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Step Action 
3. Select Values 

-Select 'Agency' as a value for the "Select Version" field 
 
Click the Agency list item. 

4. Click the Add button. 
 

5. Click the OK button. 
 

6. Click the Launch button. 
 

7. A message dialog box displays: "LI_Agg_All_Budget Rule was run successfully". 
Business Rule would update all summary totals. 
 
Click the OK button. 

 
8. Complete the Aggregate Current Budget Task 

 
Click the Complete option. 

9. Click the Next button. 
 

10.  
End of Procedure. 

1.31 - Final Review of Budget 
In this topic you will review the budget information entered. 

Procedure 
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Step Action 
1. Adjust View for Form - (Select summary level values for all page drop downs) 

 
Pages drop downs are : 
Entity : < Select Desired Agency/Division/DeptID> , Program : <Select 
All_Program>, Operating Unit: <Select All_OPR_PRODUCT>, CFDA: <Select 
All_CFDA> , Project: <Select All_Projects> 
 
For E.g. Entity: 26500 (Dept of Education), Program: All_Program, Operating 
Unit: 26500_OPR_PRODUCT, CFDA: All_CFDA, Project: All_Projects 
 
Click the Entity dropdown button to activate the menu. 

 
2. Enter the desired information into the Member field. Enter "34500 - ". 
3. Click the five-digit entity. 

 
E.G.: 
 
Click the 34500 - Department of Transportation list item. 

 
4. Click the Operating Unit dropdown button to activate the menu. 

 
5. Enter the desired information into the Member field. Enter "34500_opr". 
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Step Action 
6. Click the desired option. 

 
E.g: 
 
Click the 34500_OPR_PRODUCT list item. 

 
7. Click the CFDA dropdown button to activate the menu. 

 
8. Enter the desired information into the Member field. Enter "all_". 
9. Click the ALL_CFDA list item. 

 
10. Click the Project dropdown button to activate the menu. 

 
11. Click the All_Projects list item. 

 
12. Click the Go button. 

 
 

 
 

Step Action 
13. Review the data in the form 
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Step Action 
14. Complete the "Final Review of Budget" Task 

 
Click the Complete option. 

15. Click the Next button. 
 

16.  
End of Procedure. 

1.32 - Submit Budget for Approval 
In this topic you will submit the budget to the approver. 

Procedure 
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Step Action 
1. Select Agency 

-Select a Division level Planning Unit under the "Planning Unit" column 
 
E.g. 34500_2100001 
 
Click the 34500_2100001 list item. 

 
2. Click the Actions menu. 

 
3. Click the Change Status menu. 

 
4. -Verify that "Promote" is selected in the "Select Action" list menu 

 
Click the Select Next Owner list. 

 
5. Select the next owner in the list 

 
E.g. PUHShared_Grp_34500 
 
Click the PUHShared_Grp_34500 list item. 

 
6. Click the OK button. 

 



 

 Page 137 

Step Action 
7. A message box appears reading "Change status submitted". Current location of the 

Planning unit gets updated to Agency level 
 
Click the OK button. 

 
 

 
 

Step Action 
8. Current location of the Planning unit gets updated to Agency level 

 
E.g.: 34500 
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Step Action 
9. Click the Actions menu. 

 
10. Click the Change Status menu. 

 
11. -Verify that "Promote" is selected in the "Select Action" list menu 

 
Click the Select Next Owner list. 

 
12. Click the PUHShared_Grp_All_Agencies list item. 

 
13. Click the OK button. 

 
14. A message box appears reading "Change status submitted". Current location of the 

Planning unit gets updated to All_Agencies level 
 
Click the OK button. 
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Step Action 
15. Current location of the Planning unit gets updated to All_Agencies level 
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Step Action 
16. Complete the "Submit Budget for Approval" Task 

 
Click the Complete option. 

17. Click the Task List Home button. 
 

18. Click the Log Off object. 
 

19. Click the Yes button. 

 
20.  

End of Procedure. 

Strategic Planning 

1.33 - Provide Executive Summary 
In this topic you will answer questions regarding the strategic plans of the agency.  

Procedure 
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Step Action 
1. [Note: If you have not logged off, skip to step 8] 

 
To begin using the application, we must first Log On. 
 
The user name is not case-sensitive. 
 
Enter the desired information into the User Name: field. Enter "<User Name:>". 

2. Enter the desired information into the Password: field. Enter "<Password>". 
3. Click the Log On button. 

 
4. In order to open up the SOKPLAN application the following steps must be 

completed: 
 
Click the Navigate menu. 

 
5. Click the Applications menu. 

 
6. Click the Planning menu. 

 
7. Click the SOKPLAN menu. 

 
8. Click the Strategic Planning object. 

 
9. Click the Collapse Pane button. 

 
10. Click the Action button. 
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Step Action 
11. Adjust View for Form (Select lowest level values in page drop downs) 

 
Pages drop downs are : 
Entity : < Select Desired Agency> 
 
For E.g. Entity: 26500 
 
Click on Go 
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Step Action 
12. Provide Executive Summary 

-Navigate to the  "Response" form 
-Enter text in the "Response" form corresponding to the questions in the "Input 
Required" form 
 
[NOTE:  If you cannot read the entire question, note that you can make the column 
wider by grasping the right hand side of the column header and dragging to the 
right to make the column wider, to the left to make the column narrower.] 
 
Enter the desired information into the SP5 Response: field. Enter "Enter Values 
and Behaviors here". 

13. Click the File menu. 

 
14. Click the Save menu. 

 
15. A message dialog box displays: "The data has been saved" 

 
Click the OK button. 

 
16. Complete the "Provide Executive Summary" Task 

 
Click the Complete option. 

17. Click the Next button. 
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Step Action 
18.  

End of Procedure. 

1.34 - Goal Setting 
In this topic you will enter information regarding goals of the agency.  

Procedure 
 
 

 
 

Step Action 
1. Provide Goal Setting 

 
Enter the desired information into the Summary of long-term goals and measures: 
* field. Enter "To develop effective and successful planning". 

2. Click the File menu. 

 
3. Click the Save menu. 

 
4. A message dialog box displays: "The data has been saved" 

 
Click the OK button. 
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Step Action 
5. Click the KPMs Planning tab. 

 
6. Moving from left to right on the form, provide KPM's Planning for the following 

fields: 
 
Enter the desired information into the Goal#2/Short Description field. Enter 
"Improve planning". 

7. Enter the desired information into the G2-Line1/Short Description field. Enter 
"Project Management Skill Development". 

8. Enter the desired information into the G2-Line1/Long Description field. Enter 
"This measure in how many PM courses are utilized by State employees". 

9. Enter the desired information into the G2-Line1/Measure Values/FY14 field. Enter 
"8423". 

10. Enter the desired information into the G2-Line1/Measure Values/FY15 field. Enter 
"8423". 

11. Enter the desired information into the G2-Line1/Measure Values/FY16 field. Enter 
"8424". 

12. Enter the desired information into the G2-Line1/Measure Values/FY17 field. Enter 
"8424". 

13. Enter the desired information into the G2-Line1/Measure Values/FY18 field. Enter 
"8425". 

14. Enter the desired information into the G2-Line1/Measure Values/FY19 field. Enter 
"8425". 

15. Enter the desired information into the Measure Values Comments field. Enter 
"Number of Trips". 

16. Click the File menu. 

 
17. Click the Save menu. 

 
18. Click the Assumptions and Actions tab. 

 
19. Review Assumptions and Actions and enter text in cells if necessary 

 
Complete the "Goal Setting" Task 
 
Click the Complete option. 

20. Click the Task List Home button. 
 

21.  
End of Procedure. 
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Operational Planning Reviewer Tasks 

1.35 - Review Budget 
In this topic you will review budget information and instructions.  

Procedure 
 
 

 
 

Step Action 
1. Enter the desired information into the User Name: field. Enter "<User Name>". 
2. Enter the desired information into the Password: field. Enter "<Password>". 
3. Click the Log On button. 

 
4. Click the Navigate menu. 

 
5. Click the Applications menu. 

 
6. Click the Planning menu. 

 
7. Click the SOKPLAN menu. 
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Step Action 
8. Navigate to the Operational Planning Task and expand the sub task 

 
Click the Operational Planning Expand button. 

 
9. Click the 1. Review Budget object. 

 
10. Adjust View for Form - (Select summary level values for all page drop downs) 

 
Pages drop downs are : 
Entity : < Select Desired Agency/Division/DeptID> , Program : <Select 
All_Program>, Operating Unit: <Select All_OPR_PRODUCT>, CFDA: <Select 
All_CFDA> , Project: <Select All_Projects> 
 
For E.g.: 
 Entity: 26500 (Dept of Education), Program: All_Program, Operating Unit: 
26500_OPR_PRODUCT, CFDA: All_CFDA, Project: All_Projects 
 
Click the Entity dropdown button to activate the menu. 

 
11. Enter the desired information into the Member field. Enter "34500 -". 
12. E.g.: 

 
Click the 34500 - Department of Transportation list item. 

 
13. Click the Operating Unit dropdown button to activate the menu. 

 
14. Enter the desired information into the Member field. Enter "34500_opr". 
15. E.g.: 

 
Click the 34500_OPR_PRODUCT list item. 

 
16. Click the CFDA dropdown button to activate the menu. 

 
17. Enter the desired information into the Member field. Enter "all_cfda". 
18. E.g.: 

 
Click the ALL_CFDA list item. 

 
19. Click the Project dropdown button to activate the menu. 

 
20. Enter the desired information into the Member field. Enter "all_project". 
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Step Action 
21. E.g.: 

 
Click the All_Projects list item. 

 
22. Hide the View Pane (if not already hidden) so the whole form can be displayed 

 
Click the Collapse Pane button. 

 
23. Click the Go button. 

 
 

 
 

Step Action 
24. Use the vertical scroll bar to navigate to the funds associated with the chosen 

agency  
 
e.g. 34500 

25. Review the budget data 
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Step Action 
26. Click the Complete option. 
27. Click the Next button. 
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Step Action 
28. Read the Budget Request Instrcutions using the scroll bar to navigate through the 

PDF 
 

 

 
 

Step Action 
29. Click the Complete option. 
30. Click the Next button. 

 
31. Click the Restore Pane button. 

 
32.  

End of Procedure. 

1.36 - Review Agency and Agency Program Information 
In this topic you will review agency and agency program information.  

Procedure 
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Step Action 
1. Adjust View for Form  

 
Pages drop downs are : 
Entity : < Select Desired Agency> , Year : <Select FYXX> 
 
For E.g.: 
 Entity: 26500 (Dept of Education), Year: FY16  
 
Click the Entity button. 

 
2. Enter the desired information into the Member field. Enter "34500". 
3. Click the 5-digit agency number. 

 
E.g.  
 
Click the 34500 - Department of Transportation list item. 

 
4. Click the Go button. 

 
5. Review the data on the Agency Mailing Address tab.  Click each subsequent tab and 

review the data there as well. 
 
Click the Agency Head tab. 
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Step Action 
6. Review data 

 
Click the Alternate Contact Person tab. 

 
7. Review data 

 
Click the Agency Details tab. 

 
8. Review data 

 
Click the Agency Management tab. 

 
9. Click the Board or Commission Members tab. 

 
10. The task is now complete 

 
Click the Complete option. 

11. Click the Next button. 
 

12. Click the Next button. 
 

13. Adjust View for Form  
 
Pages drop downs are : 
Entity : < Select Desired DeptID>  
 
For E.g.: 
 Entity: 26500_0100001  
or summary level E.g. Entity: 26500 
 
Review the data displayed in the forms.  Once the data has been reviewed complete 
the task 
 
Click the Complete option. 

14. Click the Next button. 
 

15. Review the Agency Program Goals.  If necessary, click the Agency Program 
evaluation and review as well 
 
After data is reviewed complete the task 
 
Click the Complete option. 
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Step Action 
16. Click the Next button. 

 
17.  

End of Procedure. 

1.37 - Review Agency Revenue details 
In this topic you will review all agency revenue information.  

Procedure 
 
 

 
 

Step Action 
1. Navigate to the Plan Agency Revenue object in the View Plane 

 
Click the Plan Agency Revenue Expand button. 

 
2. Click the Identify anticipated Fee based revenues object. 
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Step Action 
3. Adjust View for Form (Select Summary level values in page drop downs) 

 
Pages drop downs are : 
Entity : < Select Desired DeptID> , ClassFund: <Select Desired ClassFund> 
Operating Unit: <Select Desired OU_Product> 
 
For E.g.: 
 Entity: 26500, ClassFund: 26500_CF, Operating Unit: 26500_OPR_PRODUCT 
 
Click the ClassFund dropdown button to activate the menu. 

 
4. Enter the desired information into the Member field. Enter "34500_cf". 
5. Click the roll up CF list item.  

 
E.g.:  
 
Click the 34500_CF - Department of Transportation list item. 

 
6. Click the Operating Unit dropdown button to activate the menu. 

 
7. Enter the desired information into the Member field. Enter "34500_opr". 
8. E.g.: 

 
Click the 34500_OPR_PRODUCT list item. 

 
9. Click the Go button. 

 
10. Click the Complete option. 
11. Click the Next button. 

 
12. Navigate to the Identify Grants and Pass Through to Local Gov't and Non-Profits 

object in the View Plane 
 
Click the Identify Grants and Pass Through to Local Gov't and Non-Profits 
Expand button. 

 
13. Click the Identify Grants object. 
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Step Action 
14. Adjust View for Form (Select Summary level values in page drop downs) 

 
Pages drop downs are : 
Entity : < Select Desired DeptID> , ClassFund: <Select Desired ClassFund>  
 
For E.g.: 
Entity: 26500 , ClassFund: 26500_CF 
 
Click the Entity dropdown button to activate the menu. 

 
15. Enter the desired information into the Member field. Enter "34500_68". 
16. Click the chosen department list item.  

 
E.g.: 
  
Click the 34500_6800001 list item. 

 
17. Click the ClassFund dropdown button to activate the menu. 

 
18. Enter the desired information into the Member field. Enter "34500_10006". 
19. Click the desired class fund.  

 
E.g.: 
 
Click the 34500_10006 list item. 

 
20. Click the Go button. 

 
21. Click the Complete option. 
22. Navigate to the Plan Agency Revenue object in the View Plane 

 
Click the Provide Grants details object. 

 
23. Click the CFDA dropdown button to activate the menu. 

 
24. Enter the desired information into the Member field. Enter "all_". 
25. Click the ALL_CFDA list item. 

 
26. Click the ClassFund dropdown button to activate the menu. 

 
27. Enter the desired information into the Member field. Enter "all ". 
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Step Action 
28. Click the All Class Funds list item. 

 
29. Click the Go button. 

 
 

 
 

Step Action 
30. Review the data in the form 
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Step Action 
31. Click the Complete option. 
32. Click the Next button. 

 
33. Click the Taxes object. 
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Step Action 
34. Review the data in the form 
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Step Action 
35. Click the Complete option. 
36. Click the Next button. 

 
 

 
 

Step Action 
37. Review the data in the from 
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Step Action 
38. Click the Complete option. 
39. Click the Next button. 
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Step Action 
40. Review the data in the form 

 

 
 

Step Action 
41. Click the Complete option. 
42. Click the Next button. 
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Step Action 
43. Review the data in the from 
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Step Action 
44. Click the Complete option. 
45. Click the Next button. 

 
 

 
 

Step Action 
46. Review the data in the from 
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Step Action 
47. Click the Complete option. 
48. Click the Next button. 
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Step Action 
49. Review the data in the from 

 

 
 

Step Action 
50. Click the Complete option. 
51. Click the Next button. 
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Step Action 
52. Review the data in the from 

 

 
 



 

 Page 167 

Step Action 
53. Click the Complete option. 
54. Click the Task List Home button. 

 
55.  

End of Procedure. 

1.38 - Review Agency Expenditure details 
In this topic you will review all agency expense information. 

Procedure 
 
 

 
 

Step Action 
1. Click the Plan Agency Expenditure Expand button. 

 
2. Click the Plan Statewide Program Expenses object. 
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Step Action 
3. If no changes have been made the form will retain POV selections and display data.  

If selections need to be made do the following: 
 
Adjust View for Form  (Select Summary level members) 
 
Pages drop downs are : 
Entity : < Select Desired DeptID>, Operating Unit: <Select Desired OU_PRD>, 
GL Account: <Select Total Expense Account '5'> 
 
For E.g.: 
 Entity: 26500, Operating Unit: 26500_OPR_PRODUCT, Account: '5'  
 
Review the data in form 
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Step Action 
4. Complete the "Plan Statewide Program Expenses" Task 

 
Click the Complete option. 

5. Click the Next button. 
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Step Action 
6. Review the data in form 
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Step Action 
7. Complete the "Plan Operational Expenses" Task 

 
Click the Complete option. 

8. Click the Next button. 
 

9. Click the Entity dropdown button to activate the menu. 
 

10. Enter the desired information into the Member field. Enter "34500_210". 
11. Click the desired department. 

 
E.g.  
 
Click the 34500_2100001 - Transit list item. 

 
12. Click the Go button. 

 
 

 
 

Step Action 
13. Review the data in form 
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Step Action 
14. Complete the "Identify uses of carryover and cash needs in the current year budget" 

Task 
 
Click the Complete option. 

15. Click the Next button. 
 

16. Click the Next button. 
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Step Action 
17. If necessary: 

 
Adjust View for Form (Select lowest level values in page drop downs) 
 
Pages drop downs are : 
Entity : < Select Desired DeptID>, CFDA: <Select Desired CFDA> 
 
For E.g.: 
 Entity: 26500_0100001 (Administrative Services), CFDA: 100690000 
 
Review the data in the form 
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Step Action 
18. Complete the "Provide Federal program overview" Task 

 
Click the Complete option. 

19. Click the Next button. 
 

20. Adjust View for Form (Select lowest level values in page drop downs) 
 
Pages drop downs are : 
Entity : < Select Desired DeptID>, CFDA: <Select Desired CFDA>, ClassFund: 
<Select desired ClassFund> 
 
For E.g. 
 Entity: 26500_0100001 (Administrative Services), CFDA: 100690000, ClassFund: 
26500_10000 
 
Click the Entity dropdown button to activate the menu. 

 
21. Enter the desired information into the Member field. Enter "34500 - ". 
22. Click the roll up of the business unit:   

 
E.g.: 
   
Click the 34500 - Department of Transportation list item. 
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Step Action 
23. Click the CFDA dropdown button to activate the menu. 

 
24. Enter the desired information into the Member field. Enter "all_cfda". 
25. E.g.: 

 
Click the ALL_CFDA list item. 

 
26. Click the ClassFund dropdown button to activate the menu. 

 
27. Enter the desired information into the Member field. Enter "all class". 
28. E.g.: 

 
Click the All Class Funds list item. 

 
29. Click the Go button. 

 
 

 
 

Step Action 
30. Review the data in the form 
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Step Action 
31. Complete the "Provide Federal Program details" Task 

 
Click the Complete option. 

32. Click the Next button. 
 

33. Adjust View for Form (Select lowest level values in page drop downs) 
 
Pages drop downs are: 
Entity : < Select Desired DeptID> 
 
For E.g.: 
Entity: 26500_0100001 (Administrative Services) 
 
Click the Entity dropdown button to activate the menu. 

 
34. Enter a valid value  

 
E.g.: 
  
Enter the desired information into the Member field. Enter "34500_21". 
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Step Action 
35. Click the desired department:  

 
E.g.:  
 
Click the 34500_2100001 - Transit list item. 

 
36. Click the Go button. 

 
37. Complete the "Agency Property Maintenance Summary" Task 

 
Click the Complete option. 

38. Click the Next button. 
 

 

 
 

Step Action 
39. Review the data in the form 
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Step Action 
40. Complete the "Plan Property Maintenance Expenses" Task 

 
Click the Complete option. 

41. Click the Next button. 
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Step Action 
42. Review the responses in the form 
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Step Action 
43. Complete the "Identify Legislation Needs" Task 

 
Click the Complete option. 

44. Click the Next button. 
 

45.  
End of Procedure. 

1.39 - Review and Approve Operational Decision Package 
In this topic you will approve or deny a decision package. 

Procedure 
 
 

 
 

Step Action 
1. Click the decision package of choice 

  
E.g. : 
 
Click the 34500_New Decision Package cell. 
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Step Action 
2. -Navigate to justifications for Decision Package. 

 
Click the Justification tab. 

 
 

 
 

Step Action 
3. Use the vertical scroll bar to review the Justification summary questions 
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Step Action 
4. Click the Notes and Attachments tab. 
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Step Action 
5. Review the Note(s)  

 
 

 
 

Step Action 
6. Click the Attachments tab. 

 
7. Review the Attachment(s) 

 
Click the Attachment link. 
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Step Action 
8. Here there will be an option to open or save the document.  We will just cancel and 

move to the next step. 
 
Click the Cancel button. 
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Step Action 
9. Navigate to the top of the page and close the opened document's tab 

 
E.g.: 
 
Click the [X] 34500_Operating Decision Package.docx tab. 

 
10. Navigate to the Budget Requests 

 
Click the Budget Requests tab. 

 
11. Click the desired budget request  

 
E.g.:  
 
Click the 34500_Budget Request 1 cell. 

12. Click the Approval Status tab. 

 
13. Click the roll up business unit in the Planning Unit cell:  

 
E.g.: 
 
Click the 34500 cell. 

14. Click the Actions menu. 
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Step Action 
15. Click the Change Status menu. 

 
16. Click the Select Action list. 

 
17. Click the Approve list item. 

 
18. Click the Select Next Owner list. 

 
19. Click the PUHShared_Grp_All_Agencies list item. 

 
20. Click the OK button. 

 
21. A message box appears reading "Change status submitted." 

 
Click the OK button. 

 
22. Click the desired decision package cell: 

 
E.g.: 
  
Click the 34500_New Decision Package cell. 

23. Refresh the page 
 
Click the Restore Pane button. 

 
24. Click the 7. Identify Legislation Needs object. 

 
25. Click the 8. Operational Decision Package object. 

 
26. Click the Collapse Pane button. 
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Step Action 
27. Review that the decision package has been approved by checking that "Yes"  is 

displaying in the Approved column 
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Step Action 
28. Click the Complete option. 
29. Click the Next button. 

 
30.  

End of Procedure. 

1.40 - Approve Budget 
In this topic you will approve or deny an agency’s proposed budget.  

Procedure 
 
 

 
 

Step Action 
1. Show the View Pane (if hidden) 

 
Click the Restore Pane button. 

 
2. Click the 11. Submit Budget for Approval object. 
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Step Action 
3. Navigate to the Planning Unit for the roll up business unit:  e.g. 34500 
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Step Action 
4. Click the business unit cell: e.g.  

 
Click the 34500 cell. 

5. Click the Actions menu. 

 
6. Click the Change Status menu. 

 
7. Click the Select Action list. 

 
8. Click the Approve list item. 

 
9. Click the Select Next Owner list. 

 
10. Click the PUHShared_Grp_All_Agencies list item. 

 
11. Click the OK button. 

 
12. A message displays reading "Change status submitted" 

 
Click the OK button. 
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Step Action 
13. Veryify that the budget has been approved 

 
 

 
 

Step Action 
14. Complete the "Approve Budget" Task 

 
Click the Complete option. 

15. Click the Task List Home button. 
 

16. Click the Log Off object. 
 

17. Click the Yes button. 

 
18.  

End of Procedure. 
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